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Bab I Pendahuluan 
 

 

A. DESKRIPSI JUDUL 

Mengembangkan Aplikasi Multimedia merupakan modul teori dan atau 

praktikum terakhir dari rangkaian modul Program Keahlian Multimedia yang 

membahas dasar-dasar pengembangan aplikasi multimedia dengan software 

Macromedia Director MX 2004, selanjutnya disebut Director MX.  

Modul ini terdiri dari 4 (empat) kegiatan belajar, yaitu:  

1.  Mempersiapkan software Multimedia 

2.  Mengenali menu dan interface, serta membuat, membuka, menyimpan file 

multimedia 

3.  Melakukan pembuatan halaman multimedia interaktif 

4.  Melakukan finalisasi (packaging) hasil pengembangan multimedia. 

Dengan menguasai modul ini diharapkan peserta diklat mampu 

mempersiapkan software aplikasi multimedia, membuat halaman multimedia 

interaktif, sampai dengan finalisasi hasil pengembangan aplikasi multimedia. 

 

B. PRASYARAT 

Kemampuan awal yang dipersyaratkan untuk mempelajari modul ini adalah : 

1. SWR.OPR.408.(1).A : Mengembangkan Ilustrasi Digital 

2. SWR.OPR.409.(1).A : Mengembangkan Pencitraan Digital 

3. SWR.OPR.415.(1).A* : Mengembangkan Animasi Dimensi Dua (2D) 

4. SWR.OPR.419.(1).A* : Menyunting Suara  

5. SWR.OPR.420.(1).A* : Menyunting Video 
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C. PETUNJUK PENGGUNAAN MODUL 

1. Petunjuk Bagi Siswa 

Siswa diharapkan mampu berperan aktif dan berinteraksi dengan sumber 

belajar yang mendukungnya, karena itu harus diperhatikan beberapa hal 

sebagai berikut : 

 

1.1 Langkah–langkah Belajar 

Modul ini berisi materi mengenai kompetensi Mengembangkan Aplikasi 

Multimedia dengan program aplikasi Director MX, oleh sebab itu perlu 

diperhatikan beberapa hal agar peserta diklat lebih berkompeten dan 

profesional, yaitu: 

1.1.1 Apa yang harus dikerjakan pertama kali dalam mengoperasikan 

program Director MX? 

1.1.2 Bagaimana cara:  

a. mempersiapkan software multimedia?  

b. mengenali menu dan interface, serta membuat, membuka, 

menyimpan file multimedia?  

c. melakukan pembuatan halaman multimedia interaktif? 

d. melakukan finalisasi (packaging) hasil pengembangan 

multimedia? 

1.1.3 Apakah pengoperasian program Director MX sudah sesuai 

prosedur? 

 

1.2 Perlengkapan yang Harus Disiapkan 

Untuk menunjang kelancaran tugas yang akan Anda lakukan, maka 

siapkan seluruh perlengkapan yang diperlukan sesuai dengan jenis 

tugas pada masing-masing kegiatan pemelajaran. 
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1.3. Hasil Pelatihan 

Anda akan mampu melakukan tugas/pekerjaan Mengembangkan 

Aplikasi Multimedia sesuai dengan prosedur pengoperasian dan 

membuat obyek-obyek multimedia yang dikehendaki. 

 

2. Peran Guru 

Guru yang akan mengajarkan modul ini hendaknya mempersiapkan diri 

sebaik-baiknya yaitu mencakup aspek strategi pemelajaran, penguasaan 

materi, pemilihan metode, alat bantu media pemelajaran, dan perangkat 

evaluasinya. 

 

D. TUJUAN AKHIR 

Setelah mempelajari modul ini, peserta diklat diharapkan kompeten dan 

profesional melakukan tugas/pekerjaan Mengembangkan Aplikasi Multimedia. 
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E. KOMPETENSI 

Kompetensi : Mengembangkan Aplikasi Multimedia 

 Kode  : SWR.OPR.416.(1).A 

 Durasi pemelajaran : 240 jam @ 45 menit 

 

A B C D E F G LEVEL KOMPETENSI KUNCI 
3 3 2 3 2 3 3 

 

KONDISI KINERJA 

1. Dalam melaksanakan unit kompetensi ini harus didukung dengan tersedianya: 
 Software multimedia sudah terinstalasiasi    
 User manual software multimedia yang digunakan 
 SOP yang berlaku di perusahaan  
 Peralatan dan instrumen yang terkait dengan pelaksanaan unit kompetensi ini 

2. Unit Kompetensi yang harus dikuasai sebelumnya:  
 HDW.OPR.107.(1).A Mengoperasikan Periferal Multimedia 
 DTA.OPR.102.(2).B Melakukan Entry Data [Multimedia] dengan menggunakan Image Scanner (Level 2) 

3. Pengetahuan yang dibutuhkan: 
 Pengoperasian Komputer 
 Pengoperasian Sistem Operasi sesuai dengan Instruction Manual 
 Objek gambar dan karakteristiknya, serta komposisi gambar dan warna 
 Free-hand drawing 
 On-site training sesuai dengan software yang digunakan 
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MATERI POKOK PEMELAJARAN 
SUB KOMPETENSI KRITERIA KINERJA LINGKUP BELAJAR 

SIKAP PENGETAHUAN KETERAMPILAN 
1. Mempersiapkan 

software 
multimedia 

 Software multimedia 
telah terinstalasi dan 
dapat berjalan 
normal 

 User manual software 
multimedia sudah 
disediakan dan 
dipahami 

 Perangkat komputer 
sudah dinyalakan, 
dengan sistem 
operasi dan 
persyaratan sesuai 
dengan Installation 
manual dan SOP 
yang berlaku 

 Software multimedia 
dijalankan. 

 

 Pengenalan software 
multimedia 

 Mengamati 
proses aktifasi 
sistem operasi 
dan software 
multimedia 
dengan seksama 

 Menjelaskan 
fungsi software 
multimedia 

 Menyalakan 
komputer sesuai 
dengan 
Installation 
manual dan SOP 

 Menjalankan 
software 
multimedia sesuai 
prosedur.  
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MATERI POKOK PEMELAJARAN 
SUB KOMPETENSI KRITERIA KINERJA LINGKUP BELAJAR 

SIKAP PENGETAHUAN KETERAMPILAN 
2. Mengenali menu 

dan interface, 
serta membuat, 
membuka, 
menyimpan file 
multimedia 

 Objek multimedia, 
menu, dan interface 
yang disediakan 
software multimedia 
beserta Shortcut-nya 
dikenali berdasarkan 
user manual 

 Fitur pengelolaan file 
software multimedia 
dapat digunakan, 
seperti: buat/create/ 
new, simpan/save, 
buka/ open, simpan 
dengan nama lain/ 
save as. 

 Fasilitas siap pakai 
seperti wizard, 
libraries, atau 
template pada 
software multimedia 
dimanfaatkan untuk 
pembuatan 
multimedia 
sederhana 

 Penyimpanan file 
software multimedia 
menggunakan format 
yang dikenal 

 

 Objek multimedia, 
menu dan interface 
software multimedia 

 Fitur pengelolaan file 
software multimedia 

 Fasilitas wizard, 
libraries atau wizard 

 Teknik penyimpanan 
file multimedia 

 Mengenali objek 
multimedia, 
menu dan inter-
face dengan 
tepat 

 Mengenali fitur 
pengelolaan file 
software 
multimedia 
dengan tepat 

 Mencermati 
fasilitas 
wizard/libraries/ 
template 
halaman web 
sederhana 

 Mengamati 
proses 
penyimpanan file 
multimedia 
dengan seksama 

 Mengidentifikasi 
objek multimedia, 
menu dan 
interface software 
multimedia 

 Menjelaskan 
tujuan 
pengelolaan file 
software 
multimedia 

 Menjelaskan 
manfaat fasilitas 
wizard/libraries/ 
template 
multimedia 
sederhana 

 Menjelaskan motif 
penyimpanan file 
multimedia 
dengan berbagai 
format 

 Menggunakan 
menu dan 
interface software 
multimedia  secara 
tepat 

 Menggunakan fitur 
pengelolaan file 
software 
multimedia sesuai 
tujuannya 

 Membuat 
multimedia 
sederhana dengan 
fasilitas 
wizard/libraries/ 
template 

 Menyimpan file 
multimedia 
dengan menggu-
nakan format fla, 
dir, swf, exe, dsb. 
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MATERI POKOK PEMELAJARAN 
SUB KOMPETENSI KRITERIA KINERJA LINGKUP BELAJAR 

SIKAP PENGETAHUAN KETERAMPILAN 
3. Melakukan 

pembuatan 
halaman 
multimedia 
interaktif 

 Gaya dinamik dan 
interaktif dipahami 
dan diaplikasikan 
dalam pembuatan 
multimedia 

 Objek lain seperti 
teks, gambar/foto, 
animasi, suara/audio, 
dan video dapat 
dikombinasikan dan 
diintegrasikan (di-
import) ke dalam 
multimedia dengan 
menggunakan 
sofware multimedia 

 

 Gaya multimedia 

 Teknik kombinasi 
dan gabung dalam 
multimedia 

 Mengamati gaya 
multimedia 
dengan teliti 

 Mencermati 
proses kombinasi 
dan gabung 
(mixing) objek 
dalam 
multimedia 
dengan seksama 

 Membedakan 
gaya multimedia 
dinamik dan inter-
aktif 

 Menjelaskan 
tahapan proses 
kombinasi dan 
gabung (mixing) 
objek dalam 
multimedia 

 Membuat 
multimedia 
dengan gaya 
dinamik 

 Membuat 
multimedia 
dengan gaya 
interaktif 

 Mengkombinasikan 
dan menggabung-
kan objek dalam 
multimedia 
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MATERI POKOK PEMELAJARAN 
SUB KOMPETENSI KRITERIA KINERJA LINGKUP BELAJAR 

SIKAP PENGETAHUAN KETERAMPILAN 
4. Melakukan 

finalisasi 
(packaging) hasil 
pengembangan 
multimedia 

 File multimedia yang 
telah selesai 
difinalisasi dapat 
dikemas (packaging) 
ke dalam CD-ROM 
Interaktif 

 File multimedia yang 
telah selesai 
difinalisasi dapat di-
konversi (convert) 
menjadi web 
interaktif 

 

 Teknik finalisasi file 
multi-media ke 
dalam CD-ROM 
interaktif dan web 
interaktif 

 Mencermati 
proses finalisasi 
file multimedia 
ke dalam CD-
ROM interaktif 
dan web inter-
aktif dengan teliti

 Menjelaskan 
tahapan proses 
finalisasi file 
multi-media ke 
dalam CD-ROM 
interaktif dan web 
inter-aktif 

 Mengemas 
(finalisasi) paket 
file multimedia ke 
dalam CD-ROM 
interaktif dengan 
sempurna 

 Mengemas 
(finalisasi) paket 
file multimedia ke 
dalam web 
interaktif dengan 
sempurna 
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F. CEK KEMAMPUAN 

Untuk mengetahui kemampuan awal yang telah Anda miliki, maka isilah cek lis 

( ) seperti pada tabel di bawah ini dengan sikap jujur dan dapat 

dipertanggungjawabkan. 

 

Saya dapat 
Melakukan 

Pekerjaan ini 
dengan 

Kompeten 

Sub Kompetensi Pernyataan 

Ya Tidak 

Bila Jawaban 

“Ya” Kerjakan 

1. Mempersiapkan 
software 
multimedia 

Menguasai dan terampil 
membuka dan menutup 
software Multimedia 
sesuai prosedur 

  
Tes Formatif 1 

2. Mengenali menu 
dan interface, 
serta membuat, 
membuka, 
menyimpan file 
multimedia 

 

 Objek multimedia, 
menu, dan interface 
yang disediakan 
software multimedia 
beserta Shortcut-nya 
dikenali berdasarkan 
user manual 

 Fitur pengelolaan file 
software multimedia 
dapat digunakan, 
seperti: buat/create/ 
new, simpan/save, 
buka/open, simpan 
dengan nama lain/ 
save as. 

 Fasilitas siap pakai 
seperti wizard, 
libraries, atau 
template pada 
software multimedia 
dimanfaatkan untuk 
pembuatan 
multimedia sederhana 

 Penyimpanan file 
software multimedia 
menggunakan 
berbagai format yang 
dikenal, seperti: fla, 
dir, swf, exe, dsb. 

  

Tes Formatif 2 
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3. Melakukan 
pembuatan 
halaman 
multimedia 
interaktif 

 Gaya dinamik dan 
interaktif dipahami 
dan diaplikasikan 
dalam pembuatan 
multimedia 

 Objek lain seperti 
teks, gambar/foto, 
animasi, suara/audio, 
dan video dapat 
dikombinasikan dan 
diinteg-rasikan (di-
import) ke dalam 
multimedia dengan 
menggu-nakan 
sofware multimedia 

  

Tes Formatif 3 

4. Melakukan 
finalisasi 
(packaging) hasil 
pengembangan 
multimedia 

 File multimedia yang 
telah selesai 
difinalisasi dapat 
dikemas (packaging) 
ke dalam CD-ROM 
Interaktif 

 File multimedia yang 
telah selesai 
difinalisasi dapat di-
konversi (converting) 
menjadi web interaktif 

  

Tes Formatif 4 
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Bab II Pemelajaran 
 

 

A. RENCANA PEMELAJARAN SISWA 

Kompetensi : Mengembangkan Aplikasi Multimedia 

Sub Kompetensi : 1. Mempersiapkan software multimedia 

  2. Mengenali menu dan interface, serta 
membuat, membuka, menyimpan file 
multimedia 

  3. Melakukan pembuatan halaman multimedia 
interaktif 

  4. Melakukan finalisasi (packaging) hasil 
pengembangan multimedia 

 

Jenis Kegiatan Tanggal Waktu Tempat 
Belajar 

Alasan 
Perubahan 

Tanda 
Tangan 

Guru 
1. Mempersiapkan 

software 
multimedia 

     

2. Mengenali menu 
dan interface, serta 
membuat, 
membuka, 
menyimpan file 
multimedia 

     

3. Melakukan 
pembuatan 
halaman 
multimedia 
interaktif 

     

4. Melakukan finalisasi 
(packaging) hasil 
pengembangan 
multimedia 
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B. KEGIATAN BELAJAR 

1. Kegiatan Belajar 1:  

 Mempersiapkan software multimedia 

  

1.1 Tujuan Kegiatan Pemelajaran 1 

1.1.1 Menyalakan komputer sesuai dengan Installation manual dan 

SOP.  

1.1.2 Menjalankan software multimedia sesuai prosedur.  

 

1.2 Uraian Materi 1 

Program Director MX membantu Anda dalam pembuatan animasi dan 

multimedia interaktif. Director MX memiliki fasilitas pengaturan untuk 

membuat suatu animasi per-frame, bahkan animasi dimensi tiga pun 

dapat dibuat dengan program Director MX ini. 

 

1.2.1 Program aplikasi multimedia sebagai alat bantu:  

a. pembuatan film animasi dengan bantuan perangkat digital 

maupun manual. 

b. pembuatan mesin chatting yang interaktif untuk ditampilkan 

di internet. 

c. pembuatan profil perusahaan yang berisi sejarah 

perusahaan dan produk yang dihasillkan. 

d. pembuatan promosi atau informasi kepada pihak lain secara 

interaktif.  

e. pengembangan game yang kreatif, atraktif dan interaktif 

f. pengembangan proyek presentasi pendidikan yang berisi 

ensiklopedia data-data ilmu pengetahuan yang dapat 

dikemas dalam CD atau ditampilkan di internet. 

1.2.2 Kebutuhan Sistem untuk program Director MX:  
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a. Prosesor Pentium MMX yang mendukung multimedia. 

Prosesor minimal yang diperlukan untuk membuat file tanpa 

file 3D adalah Pentium 200, sedangkan untuk 

memainkannya dapat menggunakan Pentium 166. Tetapi 

apabila Anda membuat file dengan file dengan file 3D maka 

prosesor minimal yang digunakan adalah Pentium II 266 

dengan menggunakan video graphic adapter (kartu grafis) 

yang memadai. Untuk file yang menggunakan full 3D maka 

minimal Anda harus menggunakan Pentium III 450. 

b. RAM minimal 32 MB, disarankan 64 MB atau lebih supaya 

proses komputer dapat berjalan dengan lancar. 

c. Display adapter dengan memori 8 MB, disarankan 16 MB 

atau yang lebih besar agar tampilan gambar dapat akurat 

dengan kedalaman warna gambar yang detail. Memori yang 

memadai memungkinkan Anda untuk preview ke dalam 

sistem warna yang lebih rendah. 

d. Sistem operasi Windows 98, Windows Me, Windows 2000, 

atau Windows XP. 

e. Soundcard (kartu suara) untuk mendengarkan suara dari file 

yang dibuat. 

f. Monitor yang dapat menampilkan minimal 256 warna 

dengan resolusi 800 x 600. 

g. Ruang kosong disk minimal 100 MB untuk directory program 

dan disarankan Anda memiliki ruang kosong 

h. Browser Internet Explorer versi 4 ke atas atau Netscape 

versi 4 ke atas. 

i. Scanner untuk mendigitasi gambar ke dalam komputer. 

j. Removeable disk untuk memudahkan pemindahan hard 

disk. 
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k. Modem untuk men-download dan meng-upload file-file ke 

dunia maya. 

l. Untuk me-render file, Anda memerlukan Direct-X versi 5.2 

dan disarankan Direct-X versi 7 ke atas. 

 

1.2.3 Instalasi Director MX 

Ikuti langkah ini untuk instalasi Director MX pada komputer: 

a. Masukkan CD program Director MX kedalam CD-ROM. 

Apabila autorun tidak berjalan, Anda dapat menggunakan 

pilihan Run dari menu Start. Ketikkan E:\setup.exe (drive E 

menyesuaikan dengan lokasi CD-ROM drive dalam komputer 

Anda). 

b. Selanjutnya Anda dapat menekan Next. Ikuti petunjuk 

selanjutnya yang telah tertera dalam panduan instalasi, 

yang berupa pengisian serial number (nomor seri) dan 

registrasi ke internet bila Anda merasa perlu. Klik next untuk 

melanjutkan proses berikutnya: 

 

 

 

 

 

 

 

 

 

 

 

Gambar 1. Jendela sambutan Director MX 
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Gambar 2. Jendela persetujuan lisensi 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3. Jendela opsi jenis instalasi 
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Gambar 4. Jendela pilihan lokasi instalasi 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 5. Jendela pemilihan folder program 
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Gambar 6. Jendela kesiapan memulai instalasi 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 7. Jendela proses berjalannya instalasi 
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Gambar 8. Jendela indikator proses instalasi telah tuntas 

 

 

Gambar 9. Jendela Shortcut program Director MX 
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1.2.4 Menjalankan dan keluar Director MX 

Untuk menjalankan Director MX ikuti langkah-langkah berikut: 

a. Aktifkan komputer 

b. Tunggu sampai jendela sistem Windows tampil pada 

komputer Anda. 

c. Klik kiri menu Start yang berada pada bagian pojok kiri 

bawah layar. 

 

 

Gambar 10. Start Menu pada Windows XP 

d. Geser mouse Anda ke sub menu Program, kemudian akan 

tampil kelompok program Macromedia. 

 

Gambar 11. Tampilan awal Director MX 
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e. Geser mouse Anda ke kelompok Macromedia, sehingga 

tampil sub kelompok Director MX. 

f. Klik Kanan mouse Anda pada pilihan Director MX, tunggu 

beberapa saat, setelah proses berhasil maka ditampilkan 

menu dialog seperti Gambar 11. 

g. Dengan tampilnya Director MX maka menu Anda sudah 

dapat bekerja dalam pemrograman Director MX. 

h. Untuk keluar dari program Director MX, Anda dapat memilih 

File pada menu bar, kemudian pilih Exit, atau dengan 

shortcut  Ctrl+Q.  

 

1.3 Rangkuman 1 

1.3.1 Program Director MX dapat membantu Anda dalam pembuatan:  

a. promosi interaktif,  

b. profil perusahaan,  

c. game interaktif,  

d. proyek presentasi pendidikan,  

e. mesin chatting, dan 

f. film animasi.  

 

1.3.2 Kebutuhan (minimum) sistem computer: Prosesor Pentium III 

450 dengan menggunakan:  

a. video graphic adapter,  

b. RAM 64 MB,  

c. Display adapter 16 MB,  

d. sistem operasi Windows XP,  

e. Soundcard,  

f. Monitor 256 warna dengan resolusi 800 x 600,  

g. Ruang kosong disk minimal 100 MB,  
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h. Internet Explorer,  

i. Scanner,  

j. Removeable disk,  

k. Modem, dan  

l. Direct-X versi 7. 

  

1.3.3 Prosedur instalasi program Director MX:  

a. masukkan CD program Director MX kedalam CD-ROM,  

b. memilih Run dari menu Start,  

c. mengetik E:\setup.exe,  

d. klik Next untuk melanjutkan proses instalasi,  

e. mengisi serial number (nomor seri),  

f. melakukan registrasi ke internet (bila perlu),  

g. Klik next untuk melanjutkan proses berikutnya sampai 

selesai. 

 

1.3.4 Prosedur menjalankan program Director MX:  

a. mengaktifkan komputer,  

b. klik kiri menu Start,  

c. menggeser mouse ke sub menu Program,  

d. menggeser mouse ke kelompok Macromedia,  

e. klik kanan mouse Anda pada pilihan Director MX. 

 

1.3.5 Prosedur keluar dari program Director MX:  

a. memilih File pada menu bar,  

b. memilih Exit (Ctrl+Q).  
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1.4 Tugas 1 

1.4.1 Buka program Director MX, lakukan pengamatan dengan 

membuka beberapa pilihan menu yang ada pada program 

tersebut! 

1.4.2 Kliklah beberapa tombol yang berada di bawah pilihan menu. 

Pilihan/perubahan apa yang tampil pada layar monitor? 

 

1.5 Tes Formatif 1 

1.5.1 Lakukan proses instalasi program Director MX, apabila di 

komputer Anda sudah terdapat program ini, maka lakukan 

proses Uninstal program atau Add/remove program melalui 

control panel! 

1.5.2 Jalankan program Director MX dan kemudian cobalah keluar 

untuk kembali ke sistem operasi Windows! 

 

1.6 Kunci Jawaban Formatif 1 

1.6.1 Lihat kembali materi 1 

 

1.7 Lembar Kerja 1: 

1.7.1 Alat dan bahan 

1 (Satu) unit komputer dengan spesifikasi minimum Pentium III 

450 yang telah diinstalasi program aplikasi Director MX. 

 

1.7.2 Kesehatan dan Keselamatan Kerja 

a. Membaca do’a sebelum memulai kegiatan belajar. 

b. Membaca dan memahami petunjuk praktikum pada setiap 

lembar kegiatan belajar. 

c. Memastikan komputer dalam keadaan baik dan semua kabel 

penghubung terkoneksi dengan baik. 
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d. Menjauhkan benda yang dapat mengeluarkan medan 

elektromagnetik di dekat komputer (magnet, handphone, 

dan sebagainya). 

e. Menggunakan komputer sesuai fungsinya dengan hati-hati. 

f. Setelah selesai, mematikan komputer dengan benar. 

  

1.7.3 Langkah Kerja 

a. Memeriksa semua kabel penghubung pada komputer. 

b. Menghidupkan komputer dengan menekan saklar pada 

komputer, jangan menghidupkan komputer dengan 

memasukkan steker ke stop kontak ketika saklar dalam 

keadaan on. 

c. Jika komputer telah hidup, mengaktifkan program aplikasi 

Director MX, menunggu hingga proses loading selesai. 

d. Mengamati dan mencoba berbagai pilihan menu serta 

tombol yang ada pada program aplikasi tersebut.  

e. Memahami dan menghapalkan masing-masing kegunaan 

menu dan tombol tersebut. 

f. Jika telah selesai, menutup program Director MX di 

komputer Anda dan mematikan komputer dengan benar. 
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2. Kegiatan Belajar 2:  

Mengenali menu dan interface, serta membuat, membuka, menyimpan file 

multimedia.  

 

2.1 Tujuan Kegiatan Pemelajaran 2 

2.1.1 Menggunakan menu dan interface software multimedia  secara 

tepat. 

2.1.2 Menggunakan fitur pengelolaan file software multimedia sesuai 

tujuannya. 

2.1.3 Membuat multimedia sederhana dengan fasilitas wizard/ 

libraries/ template. 

2.1.4 Menyimpan file multimedia dengan menggunakan format fla, 

dir, swf, exe, dsb. 

 

2.2 Uraian Materi 2 

2.2.1 Jendela Dasar Director MX 

Director MX memiliki 5 (lima) jendela dasar yang akan sering 

digunakan. Kelima jendela tersebut adalah: Stage, Score, Cast, 

Property Inspector, dan Control Panel. Adapun fungsi masing-

masing jendela tersebut adalah:  

a. Jendela Stage memiliki fasilitas untuk mengatur gerakan, 

tombol, rotasi, dan lain-lain. Juga fasilitas zoom in dan zoom 

out untuk mempermudah melihat Sprite lebih seksama. 

b. Jendela Score memiliki fasilitas seperti timeline pada 

program multimedia lainnya. Dalam jendela ini terdapat Cast 

yang dapat Anda gunakan untuk membuat movie. Score 

memungkinkan Anda mengatur tempo, masuknya sebuah 

gambar, dan panjang pendeknya frame. 
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c. Jendela Cast berisi bahan dan aktor yang akan dipakai 

dalam proyek. Bahan tersebut dapat berupa file animasi 

atau file video digital. 

d. Jendela Property Inspector memiliki fasilitas untuk 

mengubah karakter tinta atau ink dari Sprite, mengubah 

besar-kecilnya Sprite, memutar secara rotasi atau membuat 

skew suatu objek. 

e. Jendela Control Panel memungkinkan Anda mengontrol atau 

meneliti animasi yang Anda buat dalam Director MX. 

 

2.2.2 Menggunakan Tool Palette 

Setelah Director MX dijalankan, Tool Palette akan tampil dalam 

workspace Anda. Jika Tool Palette belum muncul dalam 

workspace, Anda harus membukanya terlebih dahulu dengan 

cara: pilih menu Window > klik Tool Palette. 

Fasilitas yang terdapat pada Tool Palette adalah: 

 

Ikon Arti dan Fungsi 

 
Arrow Tool 
Untuk memilih objek dalam jendela Stage 

 
Rotate Tool 
Untuk merotasi suatu objek atau Sprite dalam jendela Stage 

 
Hand Tool 
Untuk memindah area atau layar kerja dari jendela Stage 
atau Sprite 

 

Magnifyng Tool 
Untuk melakukan Zoom In dan Zoom Out pada jendela 
Stage 

 
Text Tool 
Untuk menuliskan teks ke dalam jendela Stage 

 
Line Tool 
Untuk membuat garis dalam jendela Stage 

 

Filled Rectangle 
Untuk membuat Sprite kotak dengan isian warna dalam 
jendela Stage yang langsung dapat digunakan 

 

Non Filled Rectangle 
Untuk membuat Sprite kotak tanpa isian warna dalam 
jendela Stage 



26

 

 

Filled Round Rectangle 
Untuk membuat Sprite kotak sudut tumpul dengan isian 
warna dalam jendela Stage 

 

Non Filled Round Rectangle 
Untuk membuat Sprite kotak sudut tumpul tanpa isian 
warna dalam jendela Stage 

 

Elipse Fill Tool 
Untuk membuat elips dengan isian warna dalam jendela 
Stage 

 
Elipse Non Fill Tool 
Untuk membuat elips tanpa isian warna dalam jendela Stage

 
Check box 
Untuk membuat check box 

 
Radio button 
Untuk membuat radio button 

 
Line Sector 
Untuk memilih jenis garis yang digunakan 

 
Pattern Box 
Untuk memilih pola atau pattern sebagai warna isi  

 

Field Tool 
Untuk membuat field teks 

 
Color Selector 
Untuk memilih warna 

 

2.2.3 Menggunakan jendela Paint 

Director MX menyediakan jendela Paint untuk menciptakan Cast 

member atau aktor animasi. Anda juga dapat menyunting file 

gambar bitmap atau file hasil scanning. Anda dapat 

memanipulasi file tersebut sesuai dengan keperluan proyek 

animasi Anda. Namun Anda dapat menyunting file dengan 

program eksternal seperti Macromedia Fireworks atau Adobe 

Photoshop. Ada 3 (tiga) cara membuka jendela Paint: 

a. Pilih menu Window > klik Paint 

b. Klik ikon Paint Window yang terletak tool bar atas Director 

MX 

c. Jika Cast Member sudah aktif, maka klik ganda Cast Member 

yang akan disunting 
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Tool yang terdapat pada jendela Paint adalah: 

Ikon Arti dan Fungsi 

 
Lasso Tool 
Untuk memilih suatu area dalam jendela Paint 

 
Marquee Tool 
Untuk memilih area kotak dalam jendela Paint 

 
Registration Point 
Untuk memindah titik registrasi 

 
Eraser 
Untuk menghapus gambar 

 
Hand Tool 
Untuk memindah layar kerja jendela Paint 

 

Magnifyng Glass 
Untuk memperbesar dan memperkecil area tampilan dalam 
jendela Paint 

 
Eye Dropper 
Untuk memilih warna yang ada dalam jendela Paint 

 
Paint Bucket 
Untuk mengisi warna pada area yang tertutup 

 
Text Tool 
Untuk menuliskan teks dalam jendela Paint 

 
Pencil Tool 
Untuk memberi efek tulisan pensil  

 
Air brush 
Untuk memberi efek sapuan air brush (cat semprot) 

 
Brush Tool 
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Untuk memberi efek sapuan kuas biasa 

 
Arc Tool 
Untuk membuat garis melengkung 

 
Line Tool 
Untuk membuat suatu garis lurus 

 

Filled Rectangle 
Untuk membuat kotak dengan isian warna solid atau 
gradient 

 
Rectangle 
Untuk membuat kotak tanpa isian warna atau line saja 

 
Filled Elipse 
Untuk membuat elips dengan isian warna solid atau gradient

 
Elipse 
Untuk membuat elips tanpa isian warna atau line saja 

 

Filled Polygon 
Untuk membuat polygon dengan isian warna solid atau 
gradient 

 
Gradient Color 
Untuk membuat polygon tanpa isian warna atau line saja 

 

Foreground and Background Color 
Untuk memilih warna foregorund dan background 

 

Pattern 
Untuk membuat pola warna sebagai isian sebuah bentuk 

 

Line Selector 

Untuk memilih garis dan ketebalannya 

 

2.2.4 Menggunakan jendela Text 

Ada kalanya suatu proyek memerlukan teks untuk menjelaskan 

sesuatu, misalnya keterangan spesifikasi barang dalam proyek 

presentasi penjualan atau sejarah perusahaan dalam proyek 

company profile. Director MX menyediakan jendela khusus 

untuk membuat teks yang dibutuhkan dalam proyek. Dengan 

jendela Text kita dapat membuat bermacam-macam variasi 

teks, antara lain scroolbar title atau 3D text. 

Fasilitas yang terdapat pada jendela Text adalah: 
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Ikon Arti dan Fungsi 
Font 
Untuk mengubah jenis font 

 
Bold 
Untuk menebalkan font 

 
Italic 
Untuk memiringkan (italic) font 

 
Underline 
Untuk menggarisbawahi (underline) font 

 
Font Size 
Untuk mengubah/menentukan ukuran font 

 

Line Spacing 
Untuk mengubah/menentukan jarak antar 
baris 

 

2.2.5 Menggunakan jendela Vector Shape 

Membuat Cast Member dengan Vector Shape amatlah 

menyenangkan. Anda dapat membuat kreasi bentuk yang tidak 

terbatas terhadap animasi. Anda dapat memanipulasi segala 

bentuk yang sudah Anda buat. Anda dapat membuat warna 

solid maupun gradien. 
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Fasilitas yang terdapat pada jendela Vector Shape adalah: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ikon Arti dan Fungsi 

 
Arrow Tool 
Untuk mengubah jenis font 

 
Pen Tool 
Untuk memilih suatu area dalam jendela Paint 

 
Registration Point 
Untuk memindah titik registrasi 

 
Hand Tool 
Untuk memindah layar kerja jendela Paint 

 

Filled Rectangle 
Untuk membuat kotak dengan isian warna solid atau 
gradient 

 
Non Filled Rectangle 
Untuk membuat kotak tanpa isian warna atau line saja 

 

Filled Round Rectangle 
Untuk membuat Sprite kotak sudut tumpul dengan isian 
warna dalam jendela Stage 

 

Non Filled Round Rectangle 
Untuk membuat Sprite kotak sudut tumpul tanpa isian 
warna dalam jendela Stage 

 
Filled Elipse 
Untuk membuat elips dengan isian warna solid atau gradient

 
Non Filled Elipse 
Untuk membuat elips tanpa isian warna atau line saja 

 
Stroke Widht 
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Untuk mengatur ketebalan garis vektor 

 

Closed Shape 
Dengan pilihan ini maka Shape menjadi area tertutup dan 
siap diisi dengan warna solid atau gradient 

 
Fill Selector 
Tombol untuk memilih jenis isian warna suatu Vector Shape 

 

Gradient Color 
Pilihan untuk menentukan warna-warna gradient pada suatu 
Vector Shape 

 
Stroke Color 
Untuk menentukan warna dari Stroke Vector Shape 

 

Fill Color 
Untuk membuat isian warna dalam Vector Shape yang 
tertutup 

 
Background Color 
Untuk menentukan warna dari Background Color 

 

2.2.6 Bekerja dengan jendela Stage 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fungsi Stage adalah untuk meletakkan bahan atau aktor 

animasi. Dari Stage Anda dapat mengatur gerakan, membalik 

posisi atau mengatur skala gambar. Dalam Stage terdapat scroll 
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yang dapat diatur naik-turun apabila aktor yang diletakkan tidak 

tampak dalam Stage. Anda dapat mengatur kemunculan suatu 

Sprite dalam Backstage, yaitu area yang tidak tampak dalam 

Stage. Secara default area tersebut berwarna abu-abu. 

 

a. Melakukan scrolling pada Stage: 

1. klik kotak scroll di pojok Stage 

2. geser ke atas atau ke bawah atau gerakan ke kiri dan ke 

kanan. 

 

b. Memindah layar kanvas: 

1. klik pada Stage 

2. tekan dan tahan Spacebar, akan muncul kursor berupa 

tangan 

3. tekan dan geser posisi kanvas ke posisi yang diinginkan. 

 

c. Mengubah ukuran Stage: 

1. pilih menu Window > Inspector > Property, akan 

ditampilkan jendela Property Inspector 

2. klik tab Movie 

3. pada baris Stage Size, ketik ukuran yang diinginkan atau 

klik panah yang mengarah ke bawah. 

 

d. Mengubah warna kanvas: 

1. pilih menu Window > Inspector > Property, akan 

ditampilkan jendela Property Inspector 

2. lihat pada baris Color di mana masih terdapat kotak 

warna putih sebagai warna default 
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3. klik pada kotak warna tersebut, perhatikan bahwa kini 

muncul palet warna, Anda dapat melakukan klik pada 

sebuah warna 

4. pilih warna yang Anda inginkan, perhatikan warna 

kanvas telah berubah. 

 

e. Menampilkan grid line: 

1. buka Property Inspector 

2. klik pada tab Guide, lihat pada kolom Grid 

3. tandai pilihan Visible, perhatikan Stage telah ada Grid 

Line. 

 

f. Mengubah warna grid line: 

1. buka Property Inspector 

2. klik kotak warna pada kolom Grid] 

3. pilih warna. Perhatikan bahwa sekarang warna Grid Line 

telah berubah. 

 

g. Mengisi grid secara manual: 

1. perhatikan pada kolom New 

2. klik dan drag pada jendela Stage kotak bertanda plus 

dengan grid, perhatikan kini Anda telah membuat grid 

secara vertikal atau horisontal. 

 

h. Menghilangkan grid: 

1. perhatikan kolom New 

2. klik tab Remove All dan perhatikan kini Grid telah hilang. 
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i. Zoom Stage: 

1. dari menu Window > Tool Palette, akan ditampilkan Tool 

Palette 

2. klik pada Magnifying Glass 

3. arahkan tool Magnifying Glass pada Stage. 

 

j. Mengatur Stage secara otomatis: 

1. buka kotak dialog General Preferences 

2. dari kotak dialog General Preferences yang muncul pilih 

Match Current Movie 

3. klik OK 

 

k. Meletakkan Stage di tengah: 

1. buka kotak dialog General Preferences 

2. pilih pada Center 

3. akhiri dengan mengklik OK. 

 

2.2.7 Bekerja dengan jendela Score 
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Dalam jendela Score terdapat beberapa Cast atau aktor. Dalam 

beberapa program multimedia, jendela Score disebut Timeline. 

Dalam jendela Score Anda dapat melakukan banyak hal, 

diantaranya membuat script, mengatur channel yakni memberi 

suara atau transisi serta spesial efek lainnya. Ada ratusan 

channel di dalam jendela Score yang dapat Anda gunakan 

sesuai kebutuhan animasi Anda. Jumlah channel tersebut dapat 

dikurangi maupun ditambahi. 

 

a. Menggeser Playback Head (Scrubbing): 

1. klik pada Playback Head 

2. geser pada posisi frame yang diinginkan 

3. lihat hasilnya dalam Stage apabila Anda sudah mulai 

membuat file animasi 

 

b. Frame awal dan frame akhir: 

1. frame awal dan frame akhir dari Sprite Channel dalam 

jendela Score,  

2. frame awal ditandai dengan tanda bulat 

3. frame akhir ditandai dengan tanda kotak 

4. antara tanda bulat sampai dengan tanda kotak terdapat 

garis yang menandakan adanya gerakan atau informasi. 

 

c. Frame dan keyframe: 

1. frame-frame animasi dalam Director MX  secara default 

tanpa keyframe 

2. frame animasi tanpa keyframe akan tampak kinier atau 

lurus. 
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3. Anda dapat memberi keyframe pada frame karena 

gerakan animasi dapat dibuat melengkung. 

 

d. Memberi warna Sprite channel: 

1. impor beberapa file yang berbeda, misalnya file bitmap, 

video dan audio 

2. masukkan dalam jendela Score 

3. letakkan dalam channel secara acak 

4. perhatikan di bawah kiri Anda, tampak kotak dengan 

warna berlainan 

5. klik kotak warna tersebut dengan warna yang Anda 

kehendaki, misalnya file video dengan warna kuning, 

bitmap dengan warna ungu, dan lain-lain. Perhatikan 

bahwa Sprite Channel Anda telah berubah warnanya. 

 

e. Menghilangkan sementara Sprite: 

1. impor beberapa file ke dalam Cast Member 

2. masukkan ke dalam jendela Score atau jendela Stage 

3. perhatikan kotak di sebelah kiri Sprite Channel, klik kotak 

dialog tersebut 

4. maka sekarang Sprite telah hilang. 

 

f. Memunculkan Sprite kembali: 

1. lakukan hal seperti yang disebutkan di atas 

2. klik kembali kotak tersebut untuk memunculkannya, 

perhatikan kini channel Sprite telah muncul kembali. 

 

g. Memunculkan dan menghilangkan otomatis: 

1. misal ada beberapa Sprite Channel dalam jendela Score 
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2. tekan tombol Alt dan klik kotak tersebut. 

 

h. Memberi nama Sprite channel: 

1. klik dua kali pada Sprite Channel Anda di kolom paling 

kiri jendela Score 

2. isikan sebuah nama untuk membedakan antara Sprite 

Channel satu dengan yang lain. 

 

i. Menggeser Sprite channel: 

1. anggap dalam jendela Score sudah terdapat Sprite 

Channel 

2. drag Sprite Channel tersebut ke posisi yang Anda 

inginkan dengan menggunakan mouse. 

 

j. Menggeser beberapa Sprite channel sekaligus: 

1. anggap sudah ada beberapa Sprite Channel dalam 

jendela Score 

2. klik beberapa Sprite Channel dan tekan tombol Shift , 

geser Sprite Channel ke posisi yang Anda inginkan. 

 

k. Cut dan paste Sprite: 

1. pilih Sprite Channel dalam jendela Score 

2. klik kanan Sprite Channel tersebut, dari menu yang 

muncul pilih Cut 

3. paste ke posisi yang Anda inginkan. 

 

l. Menambah frame: 

1. pilih menu Insert 
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2. klik pada Frame, dari kotak dialog yang muncul, isikan 

jumlah frame yang Anda inginkan. 

 

m. Menghapus frame: 

1. pilih menu Insert 

2. klik pada Remove Frame, maka satu frame akan hilang. 

 

n. Bekerja dengan playback head: 

1. geser posisi Playback Head ke posisi yang Anda inginkan 

2. pilih menu Modify 

3. klik pada Extended Sprite, frame kini telah terpotong 

pada posisi Playback Head 

 

o. Memisah Sprite: 

1. pilih Sprite Channel Anda 

2. pilih menu Modify 

3. klik pada Split Sprite, Sprite tersebut menjadi dua Sprite 

yang terpisah. 

 

p. Menggabungkan kembali Sprite: 

1. pilih dua Sprite yang ingin Anda gabungkan dengan 

menekan Shift 

2. pilih menu Modify, klik pada Join Sprite, perhatikan 

Sprite telah menjadi satu kembali. 

 

q. Mengurangi jumlah channel: 

1. pilih menu Window > Property Inspector, akan muncul 

Property Inspector 

2. klik pada tab Movie 
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3. perhatikan pada kotak Channel 

4. isikan dengan jumlah yang Anda inginkan. 

 

r. Bekerja dengan jendela dual Score: 

1. pilih menu Window 

2. klik New Score Window, perhatikan bahwa kini terdapat 

dua jendela score. 

 

s. Mengetahui Sprite label: 

1. perhatikan pada kotak yang bertuliskan Member dalam 

jendela Score 

2. pilih jenis spesifikasi yang Anda inginkan. 

 

t. Informasi member Sprite channel 

1. Member: apabila memilih pilihan ini, maka informasi 

akan berisi nama dan nomor urut Sprite Channel yang 

terdapat dalam jendela Cast. 

2. Behavior: apabila Anda memilih pilihan ini, maka 

informasi akan berisi jenis behavior atau jenis Script 

yang dipakai dalam Sprite Channel tersebut. 

3. Location: pilihan ini menampilkan lokasi Sprite Channel 

Anda dalam jendela Stage dalam x dan y koordinat. 

4. Ink: pilihan ini memunculkan jenis Ink yang dipakai 

dalam Sprite Channel Anda. 

5. Blend: pilihan ini membolehkan Anda melihat informasi 

persentasi dari jenis pencampuran atau blend warna 

Anda pada Sprite Channel. 
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6. Extended: pilihan Extended memunculkan semua 

pilihan secara lengkap, namun hal ini akan menyita 

workspace Anda. 

 

2.2.8 Bekerja dengan jendela Cast 

Jendela Cast berisi Cast Member yang berupa file video, file 

animasi dari program Macromedia Flash, file bitmap, atau file 

audio. Dalam jendela Cast, aktor-aktor dapat diorganisasi dan 

disimpan sebelum Anda mengolahnya dalam jendela Stage. 

Cast Member juga dapat dibuat dari jendela Paint atau Text 

Tool yang disediakan oleh Director MX. Saat Anda mengolah 

gambar pada Paint, secara otomatis Cast akan melakukan 

update pada Cast Member. 

 

 

 

 

 

 

 

 

 

 

Program eksternal yang dapat dipakai antara lain Macromedia 

Fireworks atau Adobe Photoshop untuk mengolah gambar 

bitmap dan CorelDraw! Atau Adobe Illustrator untuk mengolah 

gambar citra vector: 

 

 



41

 

a. Membuka jendela Cast: 

1. pilih menu Window 

2. sorot pada Cast, maka jendela Cast akan terbuka. 

 

b. Mengimpor file: 

1. pilih menu File > Import, akan muncul kotak dialog 

Import Files into “Internal” 

2. pilih file yang akan diimpor 

3. klik OK, dan kini file Anda sudah masuk ke dalam jendela 

Cast 

4. setelah Anda mengimpor file tersebut dan muncul kotak 

dialog Image Option for …., pilih radio button 16 bit 

pada panel Color Depth atau 32 bit untuk warna yang 

detail 

5. klik OK. 

 

c. Mengimpor file dari Clipboard: 

1. pilih gambar dari computer yang ingin Anda ambil 

2. tekan tombol PrintScreen pada keyboard 

3. letakkan kursor dalam jendela Cast 

4. klik kanan, dari menu yang muncul pilih Paste Bitmap. 

 

d. Jenis-jenis file dalam Cast: 

1. Animasi Gif 
2. Behavior 
3. File Bitmap 
4. Button 
5. Checkbox 
6. Digital Video 
7. Fields 
8. Film Loops 
9. Flash Movie 

11. Cursor 
12. OLE 
13. Palette 
14. Pict 
15. Radio Button 
16. Script 
17. Vector Shape 
18. Shockwave 
19. Sound 
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10. Font  
 

e. Graphical View dan List View: 

1. perhatikan pada kotak atas pada jendela Cast, klik pada 

Cast View Style 

2. Cast Anda telah berubah menjadi graphical view. 

 

f. Menyunting Cast Member script: 

1. pilih Script Cast yang Anda inginkan 

2. klik ikon Cast Member Script, akan muncul lembar script. 

 

g. Jumlah jendela Cast: 

1. pilih menu Edit > Preferences > Cast, akan muncul kotak 

dialog Cast Window Preference for “Internal” 

2. pilih radio button Thumbnail Visible, pilih jumlah 

thumbnail yang Anda inginkan dengan melakukan klik 

panah bawah 

3. klik OK. 

 

h. Jumlah baris jendela Cast: 

1. buka kotak dialog Cast Window Preferences for 

”Internal” 

2. pada panel Row Width, klik panah bawah untuk memilih 

pilihan yang ada, pilihan tersebut ada 8, 10 dan 20, pilih 

salah satu yang sesuai dengan kebutuhan Anda. 

 

i. Ukuran thumbnail: 

1. buka kotak dialog Cast Window Preferences for 

“Internal” 
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2. pada Thumbnail Size terdapat pilihan Small, Medium dan 

Large, pilih yang sesuai dengan kebutuhan Anda 

3. klik OK. 

 

j. Label Cast Member: 

1. buka kotak dialog Cast Window Preferences for 

“Internal” 

2. pada kolom Label, pilih yang sesuai dengan keinginan 

3. klik OK. 

 

k. Memilih Cast Member: 

1. gunakan kursor mouse untuk memilih Cast Member Anda 

2. gunakan ikon panah yang berada di atas Cast Member 

3. gunakan tombol Shift apabila Anda ingin memilih jumlah 

Cast Member sekaligus. 

 

l. Mencari Cast Member: 

1. pilih menu Edit > Find > Cast Member 

2. pilih Cast Member yang Anda cari, klik Select. 

 

m. Melakukan drag pada Cast: 

1. cari Cast Member menggunakan fasilitas Find 

2. pilih Select 

3. selanjutnya drag Cast Member Anda ke tempat yang 

baru atau ke dalam Stage dan letakkan Cast Member 

tersebut. 

 

n. Menampilkan properties dari Cast Member: 

1. klik kanan dari Cast 
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2. Property Inspector akan muncul. 

 

o. Mengganti nama Cast Member: 

1. buka jendela Cast, perhatikan kotak yang berisi tulisan 

file asli 

2. sorot dengan mouse dan ganti dengan nama file yang 

baru 

3. tekan Enter, maka Cast Member Anda telah berubah 

menjadi nama yang baru. 

 

p. Membuka Cast baru: 

1. pilih menu File > New > Cast, langkah ini akan 

membuka kota dialog New Cast 

2. isikan nama Cast Anda 

3. klik OK. 

 

q. Menggunakan External Cast: 

1. pilih menu File > New > Cast 

2. dari kotak dialog New Cast yang muncul, pilih radio 

button External, hilangkan tanda cek pada Use Current 

Movie 

3. beri nama Cast tersebut 

4. klik OK. 

 

r. Memanggil kembali Cast: 

1. pastikan Anda sudah melakukan langkah sebelumnya 

2. pilih menu File 

3. pilih pada Recent Cast. 

 



45

 

s. Tipe file yang dapat diimpor ke jendela Cast: 

1. File Image: JPG, BMP, GIF, PSD, TIFF, Targa, PICT 

2. File Audio: AIFF, WAV, MP3 Shockwave Audio 

3. File Video: AVI, QuickTime, MPG-1, DVD 

4. Teks: HTML, RTF, Lingo Script 

 

t. Menyusun Cast Member: 

1. pastikan bahwa Cast Member Anda dalam keadaan aktif 

2. pilih menu Edit > Select All, maka Cast Member akan 

terpilih semua 

3. pilih menu Modify > Sort 

4. Ada beberapa pilihan yang dapat digunakan untuk 

menyusun Cast Member: 

• Usage Score: pilihan default dari Director MX 

• Media Type: mengelompokkan file berdasarkan 

jenis file 

• Name: menyusun Cast Member urut berdasarkan 

alfabet nama 

• Size: menyusun file berdasarkan ukuran file 

• Empty at End Places: pilihan ini digunakan untuk 

mengosongkan halaman terakhir atau merapatkan 

susunan. 

 

u. Memberikan komentar pada Cast: 

1. klik kanan pada Cast Member 

2. pilih Cast Properties 

3. dari jendela Property Inspector, pilih tab Member 

4. pada kolom Commentx tuliskan uraian Anda 
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2.2.9 Bekerja dengan jendela Property Inspector 

Property Inspector memperbolehkan Anda melakukan beberapa 

hal antara lain: menyunting spesifikasi file Cast atau aktor 

Anda. Dalam Property Inspector terdapat tab-tab yang dapat 

digunakan untuk mengubah spesifikasi file Anda. 

Tampilan Property Inspector dapat berupa Cast view atau list 

view, tergantung keinginan ataupun kebiasaan Anda dalam 

bekerja. Dalam jendela Property Inspector Anda dapat melihat 

ukuran file, kapan dibuat, dan siapa yang membuat. 

a. Membuka Property Inspector: 

1. pilih menu Window 

2. klik pada Property Inspector. 

 

b. Mengubah dari list view ke graphical view: 



47

 

1. perhatikan ikon di sudut kanan atas Property Inspector 

2. klik ikon tersebut, maka Property Inspector telah 

berubah menjadi List View. 

 

c. Mengubah nama Member: 

1. buka Property Inspector 

2. klik pada tab Member 

3. perhatikan pada tulisan Name 

4. isikan nama file Anda yang baru dan tekan Enter. 

 

d. Memberikan komentar atas file: 

1. buka Property Inspector 

2. klik pada tab Member 

3. lihat pada kolom Comment 

4. isikan uraian Anda. 

 

e. Menyunting file: 

1. buka Property Inspector Anda 

2. klik tab Member 

3. perhatikan tab Edit yang ada di bawah 

4. klik tab tersebut, akan muncul jendela lain dari lembar 

kerja Anda. Hal ini tergantung dari file apa yang Anda 

pakai. 

 

f. Mengganti nama Cast: 

1. pastikan Cast Member yang terpilih 

2. buka Property Inspector 

3. klik pada tab Cast 

4. isikan nama Cast dengan nama yang baru. 
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g. Mengubah jumlah Score: 

1. pastikan jendela Stage dalam keadaan aktif, buka 

Property Inspector bila belum terbuka 

2. klik tab Sprite, perhatikan pada ikon persis di bawah tab 

Start Frame 

3. isikan nomor frame Anda di mana frame itu mulai 

berjalan 

4. lihat pada End Frame, isikan frame terakhir. 

 

h. Mengunci Sprite: 

1. pastikan jendela Stage dalam keadaan aktif, buka 

Property Inspector 

2. klik pada tab Sprite  

3. lihat pada ikon berbentuk gembok 

4. klik ikon tersebut untuk mengunci Sprite Anda. 

 

i. Membalik Sprite (Horizontal): 

1. buka Property Inspector 

2. klik pada tab Sprite, perhatikan ikon Flip Horizontal dan 

klik ikon tersebut. 

 

j. Membalik Sprite (Vertikal): 

1. pastikan jendela Stage aktif 

2. buka Property Inspector 

3. klik Flip Vertical. 

 

k. Mengatur warna Sprite: 

1. pastika jendela Stage dalam kondisi aktif 

2. pada Property Inspector klik Sprite tab 
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3. perhatikan tulisan Back Color 

4. pilih warna baru dengan menekan kotak warna di 

sebelahnya, perhatikan bahwa Anda tidak perlu memilih 

warna yang jauh berbeda dari warna semula 

5. Anda juga dapat mengaplikasikannya pada warna 

Foreground Color 

6. perhatikan bahwa warna Sprite telah berubah. 

 

l. Memindah letak Sprite: 

1. buka Property Inspector dan klik pada tab Sprite 

2. perhatikan ikon-ikon yang bertuliskan angka-angka 

3. apabila belum terbuka, Anda dapat meng-expand kolom 

tersebut 

4. dalam kolom ”x” isikan koordinat ”y” dari Sprite yang 

ingin Anda ubah 

5. pada kolom ”y” isi derajat ”y” yang ingin Anda ubah ke 

dalam y yang baru. 

 

m. Mengubah panjang dan lebar: 

1. lakukan langkah 1 sampai langkah 3 pada sub bahasan 

Memindah Letak Sprite 

2. dalam kolom “w” yang mengindikasikan Width atau lebar 

Sprite isikan nomor yang baru 

3. begitu juga isikan pada kolom “h” atau Height Anda yang 

baru 

4. tekan Enter untuk mengakhiri. 

 

 

n. Melakukan rotasi: 
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1. buka Property Inspector 

2. perhatikan ikon Rotation Angle 

3. isikan menurut ukuran yang Anda kehendaki, angka plus 

minus menghasilkan arah rotasi yang berbeda-beda. 

 

o. Melakukan skew Sprite: 

1. lakukan seperti yang telah disebutkan di atas 

2. lihat pada kolom Skew Angle 

3. isikan arah kemiringan yang Anda inginkan. 

 

p. Membatalkan semua perintah: 

1. lakukan langkah awal seperti yang sudah disebutkan 

2. perhatikan pada tombol Restore All, klik tombol tersebut 

3. perhatikan Sprite berubah ke bentuk semula kembali. 

 

q. Mengubah ukuran Sprite: 

1. pastikan jendela Stage terpilih, buka Property Inspector 

bila belum terbuka 

2. klik tab Sprite, lihat pada Scale, klik tombol tersebut, 

akan muncul menu lagi, isikan persentase ukuran 

gambar yang Anda inginkan 

3. Klik OK untuk mengakhiri. 

 

r. Memberi nama Behavior: 

1. perhatikan tab Behavior pada Property Inspector yang 

terbuka, klik pada ikon plus (+) 

2. akan muncul menu New behavior, klik menu tersebut 

3. isikan nama behavior Anda yang baru. 

s. Mengganti warna palette: 
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1. buka Property Inspector 

2. klik tab Bitmap 

3. perhatikan pada Color Palette, pada drop-down menu 

Palette pilih yang Anda inginkan. 

 

2.2.10 Bekerja dengan jendela Control Panel 

a. Control Panel memungkinkan Anda mengontrol atau meneliti 

animasi yang Anda buat dalam Director MX. Anda dapat 

menghentikan, memajukan satu frame, atau memundurkan 

satu frame, dan mengubah berapa frame per-detik yang 

Anda inginkan. 

 

 

1. melakukan Rewind 

2. menghentikan animasi 

3. menjalankan animasi 

4. memainkan frame ke belakang 

5. memainkan frame ke depan 

6. letak frame berhenti 

7. jumlah frame per-detik ataupun fps yang dapat dipilih 

8. Actual Tempo 

9. melakukan Loop atau mematikannya 

10. memanipulasi suara 

11. memilih suatu pilihan pada frame. 

 

b. Memainkan animasi: 

1. pilih menu Window > Control Panel 

2. pilih Play, animasi tersebut akan berjalan 
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c. Menghentikan animasi: 

1. buka Control Panel 

2. main animasi 

3. pilih tombol Stop. 

 

d. Me-rewind Animasi: 

1. buka Control Panel 

2. mainkan animasi sampai selesai 

3. klik Rewind, maka animasi akan dimainkan mulai dari 

awal lagi. 

 

e. Mengatur volume: 

1. buka Control Panel 

2. perhatikan ikon volume, klik ikon tersebut 

3. pilih salah satu volume yang ingin Anda hasilkan. 

 

f. Loop-Playback: 

1. buka Control Panel 

2. nonaktifkan ikon Loop Playback, maka animasi akan 

dimainkan sekali saja. 

 

g. Mengubah frames per-Second: 

1. buka Control Panel Anda (bila belum terbuka) 

2. perhatikan tulisan fps, disana tertera angka 15, Anda 

dapat mengisinya dengan angka yang lebih tinggi 

melalui ikon panah atau mengetiknya melalui keyboard. 
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h. Memainkan Frame yang dikehendaki: 

1. pilih sebagian frame animasi yang ingin Anda mainkan 

dalam jendela Score 

2. buka Control Panel (bila belum terbuka) 

3. tekan tombol pada ikon Selected Frames Only 

4. mainkan animasi Anda, animasi hanya akan berputar 

pada frame yang Anda pilih. 

 

i. Memajukan dan memundurkan animasi per-frame: 

1. buka Control Panel (bila belum terbuka) 

2. klik tombol Step Forward, animasi akan maju satu frame 

3. tekan tombol Step Backward, animasi akan mundir satu 

frame. 

 

2.2.11 Shortcut 

Shortcut adalah metode untuk mengaktifkan menu-menu 

pilihan melalui penekanan tombol atau kombinasi beberapa 

tombol. Dengan metode ini proses pekerjaan akan menjadi 

lebih cepat dari pada melalui drag and drop menu dengan 

mouse. Namun kekurangannya adalah pengguna harus 

menghafal Shortcut tersebut untuk dapat menggunakannya. 

Tabel berikut ini menunjukkan Shortcut yang ada pada Director 

MX. Label diatas tabel adalah nama menu atau submenu, 

sedangkan kolom sebelah kiri tabel adalah perintah yang dapat 

dikerjakan dengan penekanan tombol Shortcut pada kolom 

sebelah kanan tabel. Tanda plus (+) merupakan tanda 

kombinasi dari tombol yang ditekan, misal: Ctrl+N, maka 

tombol yang ditekan adalah tombol Control diikuti tombol N, 

ditekan secara bersamaan. Tanda Plus (+) tidak ikut ditekan. 
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a. Menu FILE 

Perintah Shortcut 
New  
Open...  Ctrl+O 
Close  Ctrl+F4 
Save  Ctrl+S 
Save As...  
Save and Compact  
Save All  
Revert  
Import...  Ctrl+R 
Export...  Ctrl+Shift+R 
Create Projector...  
Publish Settings...  
Publish  Ctrl+Shift+S 
Preview in Browse  F12 
Page Setup...  Ctrl+Shift+P 
Print...  Ctrl+P 
Send Mail  
Recent Movies  
Recent Casts  
Exit  Alt+F4 

 
b. Submenu New 

Perintah Shortcut 
• Movie  Ctrl+N 
• Cast  Ctrl+Alt+N 

 
c. Menu EDIT 

Perintah Shortcut 
Undo  Ctrl+Z 
Repeat  Ctrl+Y 
Cut  Ctrl+X 
Copy  Ctrl+C 
Paste Bitmap  Ctrl+V 
Paste Special  
Clear Del  
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Duplicate  Ctrl+D 
Select All  Ctrl+A 
Invert Selection  
Find  
Find Again  Ctrl+Alt+F 
Replace Again  Ctrl+Alt+E 
Edit Sprite Frames  Ctrl+Alt+] 
Edit Entire Sprite  Ctrl+Alt+[ 
Exchange Cast Members  Ctrl+E 
Edit Cast Member  
Launch External Editor  Ctrl+, 
Preference  

 
d. Submenu Paste Special 

Perintah Shortcut 
• Insert  
• Using OLE...  
• Relative  

 
e. Submenu Find 

Perintah Shortcut 
• Text...  Ctrl+F 
• Handler...  Ctrl+Shift+; 
• Cast Member...  Ctrl+; 
• Selection  Ctrl+/ 

 
f. Submenu Preference 

Perintah Shortcut 
• General...  Ctrl+U 
• Network...  
• Score...  
• Sprite...  
• Cast...  
• Paint...  
• Editors...  
• Script...  
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g. Menu VIEW 

Perintah Shortcut 
Marker  
Display  
Zoom  
Cast  
Guides and Grid  
Rulers  Ctrl+Shift+Alt+R 
Sprite Overlay  
Control Toolbar  Ctrl+Shift+H 
Keyframes  Ctrl+Shift+Alt+K 
Sprite Labels  
Onion Skin  
Full Screen  Ctrl+Alt+1 
Standard View  Ctrl+Alt+0 

 
h. Submenu Marker 

Perintah Shortcut 
• Previous  Ctrl+Left 
• Next  Ctrl+Right 

 
i. Submenu Display 

Perintah Shortcut 
• Cast Member  
• Behavior  
• Location  
• Ink  
• Blend  
• Extended  

 
j. Submenu Zoom 

Perintah Shortcut 
• Zoom Stage In  Ctrl+ + 
• Zoom Stage Out  Ctrl+ - 
• 12 % (1)  
• 25 % (2)  
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• 50 % (3)  
• 100 % (5)  
• 200 % (7)  
• 400 % (8)  
• 800 % (9)  

 
k. Submenu Cast 

Perintah Shortcut 
• List  
• Thumbnail  

 
l. Submenu Guides and Grid 

Perintah Shortcut 
• Show Grid Ctrl+Shift+Alt+G 
• Snap To Grid Ctrl+Alt+G 
• Show Guides Ctrl+Shift+Alt+D 
• Snap To Guides Ctrl+Shift+G 
• Lock Guides  
• Setting...  

 
m. Submenu Sprite Overlay 

Perintah Shortcut 
• Show Info  Ctrl+Shift+Alt+O 
• Show Paths  Ctrl+Shift+Alt+H 
• Settings...  

 
n. Submenu Sprite Labels 

Perintah Shortcut 
• Keyframes  
• Changes Only  
• Every Frame  
• First Frame  
• None  

 
o. Menu INSERT 

Perintah Shortcut 
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Keyframe  Ctrl+Alt+K 
Remove Keyframe  
Frames  Ctrl+Shift+] 
Remove Frame  Ctrl+[ 
Marker  
Media Element  
Control  
Fireworks  
OLE Object...  
Film Loop...  

 
p. Submenu Media Element 

Perintah Shortcut 
• Bitmap  
• Color Palette  
• QuickTime  
• Text  
• Shockwave Audio...  
• Shockwave 3D  
• RealMedia  
• Font...  
• Cursor...  
• Animated GIF...  
• Havok Physics Scene  
• Vector Shape  
• Flash Movie...  

 
q. Submenu Control 

Perintah Shortcut 
• Push Button  
• Radio Button  
• Check Box  
• Field  
• ActiveX...  

 
r. Submenu Fireworks 

Perintah Shortcut 
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• Images from Fireworks 
HTML...  

 
s. Menu MODIFY 

Perintah Shortcut 
Cast Properties...  
Cast Member  
Sprite  
Frame  
Movie  
Font...  Ctrl+Shift+T 
Paragraph...  Ctrl+Shift+Alt+T 
Lock Sprite  Ctrl+L 
Unlock sprite  Ctrl+Shift+L 
Join Sprites  Ctrl+J 
Split Sprite  Ctrl+Shift+J 
Extend Sprite  Ctrl+B 
Arrange  
Transform  
Tweak...  Ctrl+Shift+K 
Reverse Sequence  
Sort...  
Cast to Time  
Space to Time  
Transform Bitmap...  
Convert to Bitmap  

 
t. Submenu Cast Member 

Perintah Shortcut 
• Properties...  Ctrl+I 
• Script...  Ctrl+' 

 
u. Submenu Sprite 

Perintah Shortcut 
• Properties...  Ctrl+Shift+1 
• Script...  Ctrl+Shift+' 
• Tweening...  Ctrl+Shift+B 
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v. Submenu Frame 

Perintah Shortcut 
• Tempo...  
• Palette...  
• Transition...  
• Sound...  
• Script...  

 
w. Submenu Movie 

Perintah Shortcut 
• Properties...  Ctrl+Shift+D 
• Casts...  Ctrl+Shift+C 
• Xtras...  
• Playback...  

 
x. Submenu Arrange 

Perintah Shortcut 
• Bring to Front  Ctrl+Shift+Up 
• Move Forward  Ctrl+Up 
• Move Backward  Ctrl+Down 
• Send to Back  Ctrl+Shift+Down 

 
y. Submenu Transform 

Perintah Shortcut 
• Rotate Left  
• Rotate Right  
• Mirror Horizontal  
• Mirror Vertical  
• Flip Horizontal in Place  
• Flip Vertical in Place  
• Reset Width and Height  
• Reset Rotation and 

Skew  
• Reset All  

 
z. Menu CONTROL 
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Perintah Shortcut 
Play  
Stop  Ctrl+Alt+. 
Rewind  
Step Forward  Ctrl+Alt+Right 
Step Backward  Ctrl+Alt+Left 
Real-Time Recording  
Stop Recording  
Loop Playback  Ctrl+Alt+L 
Selected Frames Only  
Volume  
Disable Scripts  
Toggle Breakpoint  F9 
Watch Expression  Shift+F9 
Remove All Breakpoint  
Ignore Breakpoint  Alt+F9 
Step Script  F10 
Step Into Script  F8 
Run Script  F5 
Recompile All Scripts  Shift+F8 

 
aa. Submenu Volume 

Perintah Shortcut 
• 0 - Mute  Ctrl+Alt+M 
• 1 - Soft  
• 2  
• 3  
• 4 - Medium  
• 5  
• 6  
• 7 - Loud  

 
ab. Menu WINDOW 

Perintah Shortcut 
New Window  
Toolbar  Ctrl+Shift+Alt+8 
Tool Palette  Ctrl+7 



62

 

Property Inspector  Ctrl+Alt+S 
Answers  Alt+F1 
Script  Ctrl+0 
Stage  Ctrl+1 
Control Panel  Ctrl+2 
Cast  Ctrl+3 
Score  Ctrl+4 
Message  Ctrl+M 
Paint  Ctrl+5 
Vector Shape  Ctrl+Shift+V 
Text  Ctrl+6 
Field  Ctrl+8 
QuickTime  Ctrl+9 
Shockwave 3D  Ctrl+Shift+W 
RealMedia  Ctrl+Shift+Y 
AVI Video  
Object Inspector  Ctrl+Shift+' 
Library Palette  
Behavior Inspector  Ctrl+Alt+; 
Text Inspector  Ctrl+T 
Memory Inspector  
Align...  Ctrl+K 
Color Palette  Ctrl+Alt+7 
Markers  Ctrl+Shift+M 
Panel Sets  
Hide Panels  F4 

 
ac. Submenu Panel Sets 

Perintah Shortcut 
• Default  
• Director 8  
• Save Panel Layout...  
• Remove Panel Set...  

 
ad. Menu HELP 

Perintah Shortcut 
Welcome  
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What's New  
Director Help  F1 
Lingo Directory  
Director Support Center  
Online Registration  
Print Registration  
About Director...  

 
 

2.3 Rangkuman 2 

2.3.1 Director MX memiliki 5 (lima) jendela dasar yang akan sering 

digunakan. Kelima jendela tersebut adalah: Stage, Score, Cast, 

Property Inspector, dan Control Panel.  

2.3.2 Tool Palette adalah peralatan kerja yang disediakan untuk 

mengembangkan aplikasi multimedia pada Director MX. Fasilitas 

yang terdapat di Tool Palette adalah: (1) Arrow Tool, (2) Rotate 

Tool, (3) Hand Tool, (4) Magnifyng Tool, (5) Text Tool, (6) Line 

Tool, (7) Filled Rectangle, (8) Non Filled Rectangle, (9) Filled 

Round Rectangle, (10) Non Filled Round Rectangle, (11) Elipse 

Fill Tool, (12) Elipse Non Fill Tool, (13) Check box, (14) Radio 

button, (15) Line Sector, (16) Pattern Box, (17) Field Tool, dan 

(18) Color Selector. 

2.3.3 Paint adalah jendela yang disediakan untuk menciptakan Cast 

member atau aktor animasi serta menyunting file gambar 

bitmap atau file hasil scanning. Tool yang tersedia di jendela 

Paint adalah: (1) Lasso Tool, (2) Marquee Tool, (3) Registration  

Point, (4) Eraser, (5) Hand Tool, (6) Magnifyng Glass, (7) Eye 

Dropper, (8) Paint Bucket, (9) Text Tool, (10) Pencil Tool, (11) 

Air brush, (12) Brush Tool, (13) Arc Tool, (14) Line Tool, (15) 

Filled Rectangle, (16) Rectangle, (17) Filled Elipse, (18) Elipse, 

(19) Filled Polygon, (20) Gradient Color, (21) Foreground and 

Background Color, dan (22) Line Selector. 
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2.3.4 Text adalah jendela yang disediakan untuk membuat bermacam 

variasi teks yang dibutuhkan dalam proyek multimedia. Tool 

yang tersedia di jendela Paint adalah: (1) Font, (2) Bold, (3) 

Italic, (4) Underline, (5) Font Size, dan (6) Line Spacing. 

2.3.5 Vector Shape adalah jendela yang disediakan untuk membuat 

kreasi bentuk yang tidak terbatas terhadap animasi. Tool yang 

tersedia pada jendela Vector Shape adalah: (1) Arrow Tool, (2) 

Pen Tool, (3) Hand Tool, (4) Filled Rectangle, (5) Non Filled 

Rectangle, (6) Filled Round Rectangle, (7) Non Filled Round 

Rectangle, (8) Filled Elipse, (9) Non Filled Elipse, (10) Stroke 

Widht, (11) Closed Shape, (12) Fill Selector, (13) Gradient 

Color, (14) Stroke Color, (15) Fill Color, (16) Background Color. 

2.3.6 Stage adalah jendela yang disediakan untuk: (1) meletakkan 

bahan atau aktor animasi, (2) mengatur gerakan, membalik 

posisi atau mengatur skala gambar, dan (3) mengatur 

kemunculan suatu Sprite dalam Backstage. 

2.3.7 Score (Timeline) adalah jendela yang disediakan untuk: (1) 

membuat script, (2) mengatur channel yakni memberi suara 

atau transisi serta spesial efek lainnya. 

2.3.8 Cast adalah jendela yang memuat Cast Member berupa file 

video, file animasi dari program Macromedia Flash, file bitmap, 

atau file audio. Dalam jendela Cast kita dapat mengorganisasi 

dan menyimpan member sebelum Anda mengolahnya dalam 

jendela Stage. 

2.3.9 Property Inspector adalah fitur yang memungkinkan Anda 

menyunting spesifikasi file Cast atau aktor Anda. Dalam 

Property Inspector terdapat tab-tab yang dapat digunakan 

untuk mengubah spesifikasi file Anda. 
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2.3.10 Control Panel adalah fitur yang memungkinkan Anda 

mengontrol atau meneliti animasi yang Anda buat, seperti: (1) 

menghentikan, (2) memajukan satu frame, (3) memundurkan 

satu frame, dan (4) mengubah berapa frame per-detik yang 

Anda inginkan. 

2.3.11 Shortcut adalah metode untuk mengaktifkan menu-menu 

pilihan melalui penekanan tombol atau kombinasi beberapa 

tombol. Dengan metode ini proses pekerjaan akan menjadi 

lebih cepat dari pada melalui drag and drop menu dengan 

mouse. 

 

2.4 Tugas 2 

2.4.1 Buka program aplikasi Director MX, kemudian buka berturut-

turut jendela  kerja (1) Stage, (2) Score, (3) Cast, (4) Property 

Inspector, dan (5) Control Panel dengan menggunakan 

shortcut. Amati area kerja dan performa masing-masing jendela 

utama yang ditampilkan. 

2.4.2 Pilih dan operasikan satu per satu perangkat yang tersedia di 

Tool Palette di atas Stage. 

2.4.3 Buka jendela (1) Library Palette, (2) Paint, (3) Vector Shape, 

(4) Text, (5) Field, (6) QuickTime, (7) Shockwave 3D, (8) 

RealMedia, (9) AVI Video, dan (10) Color Palette dengan 

menggunakan shortcut. Operasikan satu per satu untuk 

mengenali fungsi masing-masing jendela pendukung. 

2.4.4 Klik Ctrl+R untuk melakukan import file teks, grafis, animasi, 

audio dan video yang formatnya berbeda-beda ke dalam 

jendela Cast, kemudian catat jenis format file mana yang dapat 

dan mana yang tidak dapat dijadikan member cast. 
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2.5 Tes Formatif 2 

2.5.1 Lakukan --- 

2.5.2 Jalankan --- 

 

2.6 Kunci Jawaban Formatif 2 

2.6.1 Lihat kembali materi 2 

 

2.7 Lembar Kerja 2 

2.7.1 Alat dan bahan 

1 (Satu) unit komputer dengan spesifikasi minimum Pentium III 

450 yang telah diinstalasi program aplikasi Director MX. 

 

2.7.2 Kesehatan dan Keselamatan Kerja 

a. Membaca do’a sebelum memulai kegiatan belajar. 

b. Membaca dan memahami petunjuk praktikum pada setiap 

lembar kegiatan belajar. 

c. Memastikan komputer dalam keadaan baik dan semua kabel 

penghubung terkoneksi dengan baik. 

d. Menjauhkan benda yang dapat mengeluarkan medan 

elektromagnetik di dekat komputer (magnet, handphone, 

dan sebagainya). 

e. Menggunakan komputer sesuai fungsinya dengan hati-hati. 

f. Setelah selesai, mematikan komputer dengan benar. 

  

2.7.3 Langkah Kerja 

a. Membuat konsep tertulis (skenario) pengembangan 

multimedia interaktif untuk presentasi profil sekolahmu yang 

meliputi unsur teks, grafis, animasi, audio, dan video. 

b. Memeriksa semua kabel penghubung pada komputer. 
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c. Menghidupkan komputer dengan menekan saklar pada 

komputer, jangan menghidupkan komputer dengan 

memasukkan steker ke stop kontak ketika saklar dalam 

keadaan on. 

d. Jika komputer telah hidup, mengaktifkan program aplikasi 

Director MX, menunggu hingga proses loading selesai. 

e. Mengamati area kerja dan mencoba berbagai fitur yang 

terdapat pada 5 (lima) jendela kerja (utama) Director MX.  

f. Mengamati dan mencoba berbagai fungsi yang terdapat 

pada 10 (sepuluh) jendela pendukung operasi Director MX. 

g. Membuat presentasi multimedia interaktif tentang profil 

sekolah dengan Director MX sesuai konsep tertulis 

(skenario) yang telah dipersiapkan. 

h. Jika telah selesai, simpan file presentasi multimedia 

interaktif (movie) tersebut dengan format MOV.  

i. Menutup program Director MX di komputer Anda dan 

mematikan komputer dengan benar. 
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3. Kegiatan Belajar 3:  

Melakukan pembuatan halaman multimedia interaktif  

 

3.1 Tujuan Kegiatan Pemelajaran 3 

3.1.1 Membuat multimedia dengan gaya linier. 

3.1.2 Membuat multimedia dengan gaya interaktif. 

3.1.3. Mengkombinasikan dan menggabungkan objek dalam 

multimedia. 

 

3.2 Uraian Materi 3 

Pembuatan aplikasi multimedia merupakan puncak kompetensi 

multimedia, disini Anda dapat bertindak kreatif sebagaimana sutradara 

(director) yang memadukan elemen teks, grafis, animasi, audio, dan 

video menjadi aplikasi multimedia yang atraktif dan interaktif. 

Pembuatan halaman multimedia merupakan portofolio bagi seorang 

pengembang multimedia (Multimedia Developer), dalam kegiatan 

belajar ini Anda akan berlatih membuat aplikasi multimedia bergaya 

dinamik dan bergaya interaktif. Multimedia dibagi menjadi 2 kategori, 

yaitu: Linier dan Interaktif. 

 

3.2.1 Multimedia Linier  

 Multimedia Linier ini sering kita jumpai di bidang penyiaran 

(broadcasting), salah satu produknya adalah TV Grafis. 

Multimedia Linier tidak memerlukan interaksi pengguna (user) 

dalam menjalankan animasi. Seperti terlihat pada gambar di 

bawah ini, di mana perpindahan tampilan A (pada detik 1) ke 

tampilan B (detik 2) ke tampilan C (detik 3) ke tampilan D 

(detik 4) dan seterusnya diperlihatkan secara linier seperti 

layaknya kita menonton sebuah film. 
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Menu Utama

A 
Kurikulum 

B 
Sarpras 

C 
Kesiswaan 

D 
Humas 

A1 A2 B1 B2

 

 

 

 

 

 

 

 

 

3.2.2 Multimedia Interaktif 

Multimedia Interaktif adalah presentasi multimedia yang dapat 

berinteraksi dengan user (pengguna), di mana user dapat 

berpindah dari sebuah menu ke menu lainnya tanpa harus 

menunggu jalannya animasi pada halaman tersebut selesai. 

Multimedia Interaktif sering digunakan dalam 

mempresentasikan produk yang memerlukan penjelasan yang 

lebih terperinci. Salah satu contohnya adalah profil sekolah 

dengan banyak submenu: 

 

 

 

 

 

 

 

Seperti terlihat pada gambar di atas: A. Kurikulum (di bawahnya 

terdapat A1 dan A2 adalah submenu), B. Sarpras (di bawahnya 

terdapat B1 dan B2 adalah submenu), C. Kesiswaan, dan D. 

Humas mewakili setiap tampilan menu yang berbeda, di mana 

A 
Kurikulum 

B 
Sarpras 

C 
Kesiswaan 

D 
Humas 

Detik 1

Detik 2

Detik 3

Detik 4
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user dapat berpindah dari satu menu ke menu lainnya dengan 

menekan tombol yang ada pada layar. 

 

3.3 Rangkuman 3 

3.3.1 Multimedia Interaktif adalah presentasi multimedia yang dapat 

berinteraksi dengan user (pengguna), di mana user dapat 

berpindah dari sebuah menu ke menu lainnya tanpa harus 

menunggu jalannya animasi pada halaman tersebut selesai. 

3.3.2 Multimedia Linier adalah presentasi multimedia yang sering kita 

jumpai di bidang penyiaran (broadcasting). Multimedia Linier 

tidak memerlukan interaksi pengguna (user) dalam 

menjalankan animasi.   

 

3.4 Tugas 3 

3.4.1 Buka program aplikasi Director MX, kemudian lakukan berbagai 

proses perekaman posisi sprite yang meliputi: (1) Step 

Recording, (2) Real Time Recording, (3) Space-to-Time 

Recording, (4) Cast-to-Time Recording, dan (5) Tweening. 

3.4.2 Gambarlah 10 garis tebal vertikal warna biru dari ukuran 

terendah hingga yang tertinggi (tidak melebihi tinggi Stage). 

Kemudian buatlah: (1) Film Loops dan (2) Reverse Sequences 

dari materi 10 garis tebal tersebut. 

3.4.3 Buatlah flow chart tentang kegiatan ekstra kurikuler siswa yang 

meliputi: 

Halaman Pembuka 

Menu Utama 

1.  Olah Raga 

 1.1 Bola Basket 

 1.2 Bola Volley 

 1.3 Bulu Tangkis 
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 1.4 Karate 

 1.5 Panjat Tebing 

 1.6 Sepak Bola 

 1.7 Silat 

 1.8 Tennis Meja 

2.  Seni Budaya 

 2.1 Seni Musik 

 2.2 Seni Suara 

 2.3 Seni Teater 

 2.4 Seni Tari 

3.  Sosial 

 3.1 Badan Dakwah Islam 

 3.2 OSIS 

 3.3 Palang Merah Remaja 

 3.4 Pasukan Pengibar Bendera 

 3.5 Pramuka 

Kemudian cari, temukan dan download grafis, animasi atau 

audio-video yang mendukung presentasi tersebut di Internet. 

Gunakan perintah: (1) Go Next, (2) Go Previous, (3) Go to the 

frame, (4) Go loop, (5) Go to frame, (6) Quit, dan (7) Projector. 

 

3.5 Tes Formatif 3 

3.5.1 Lakukan --- 

3.5.2 Jalankan --- 

 

3.6 Kunci Jawaban Formatif 3 

3.6.1 Lihat kembali materi 3 

 

3.7 Lembar Kerja 3 

3.7.1 Alat dan bahan 
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1 (Satu) unit komputer dengan spesifikasi minimum Pentium III 

450 yang telah diinstalasi program aplikasi Director MX. 

 

3.7.2 Kesehatan dan Keselamatan Kerja 

a. Membaca do’a sebelum memulai kegiatan belajar. 

b. Membaca dan memahami petunjuk praktikum pada setiap 

lembar kegiatan belajar. 

c. Memastikan komputer dalam keadaan baik dan semua kabel 

penghubung terkoneksi dengan baik. 

d. Menjauhkan benda yang dapat mengeluarkan medan 

elektromagnetik di dekat komputer (magnet, handphone, 

dan sebagainya). 

e. Menggunakan komputer sesuai fungsinya dengan hati-hati. 

f. Setelah selesai, mematikan komputer dengan benar. 

  

3.7.3 Langkah Kerja 

a. Memeriksa semua kabel penghubung pada komputer. 

b. Menghidupkan komputer dengan menekan saklar pada 

komputer, jangan menghidupkan komputer dengan 

memasukkan steker ke stop kontak ketika saklar dalam 

keadaan on. 

c. Jika komputer telah hidup, mengaktifkan program aplikasi 

Director MX, menunggu hingga proses loading selesai. 

d. Membuat folder masing-masing tugas untuk memudahkan 

pencarian sub folder dan file yang sedang dan tekah 

dikerjakan (dimodifikasi). 

e. Kumpulkan sub folder dan file sebuah tugas dalam 1 folder.  

f. Jika telah selesai, menutup program Director MX di 

komputer Anda dan mematikan komputer dengan benar. 
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4. Kegiatan Belajar 4:  

Melakukan Finalisasi (Packaging) Hasil Pengembangan Multimedia.  

 

4.1 Tujuan Kegiatan Pemelajaran 4 

4.1.1 File multimedia yang telah selesai difinalisasi dapat dikemas 

(packaging) ke dalam CD-ROM Interaktif 

4.1.2 File multimedia yang telah selesai difinalisasi dapat di-konversi 

(convert) menjadi web interaktif. 

 

4.2 Uraian Materi 4 

4.2.1 Format Digital Video 

Director MX 2004 memiliki kemampuan dalam memainkan file 

digital video. Dua buah format utama digital video yang dapat 

dimainkan oleh Director MX 2004 adalah: 

a. Video for Windows, memiliki file berakhiran AVI diproduksi 

oleh Microsoft, format ini secara umum dapat dimainkan 

pada system operasi Windows 95, 98, 2000, NT, dan XP. 

b. QuickTime (format multimedia yang dapat dimainkan pada 

dua system operasi berbeda; Macintosh dan Windows) 

diproduksi oleh Apple. QuickTime memiliki file berakhiran 

MOV. 

File digital video lainnya yang dapat dimainkan oleh Director MX 

2004 adalah Mpeg. Namun Anda harus mengintal file tambahan 

yang disebut Xtras pada subdirektori Xtras. 

Jika Anda memiliki file digital video sepanjang 1 menit (60 

detik) dengan format kecepatan 25 fps 925 frame per detik), 

berarti banyaknya rangkaian gambar yang terdapat dalam file 

tersebut adalah: 60 detik x 25 frame = 1500 gambar. 
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Makin banyak hitungan frame per second, makin halus gerakan 

gambar yang dihasilkan, namun makin besar pula file digital 

video tersebut. 

Saat ini terdapat beberapa metode kompresi yang dapat 

menekan ukuran file digital video seminimal mungkin namun 

tetap mempertahankan kualitas gambar. Anda dapat 

menemukan fasilitas kompresi tersebut saat memproduksi dan 

menyunting file digital video dengan software khusus (contoh: 

Adobe Premiere). 

 

4.2.2 Jenis Kompresi Digital Video 

Kompresi video untuk multimedia secara umum dibagi menjadi 

dua jenis, yaitu Video for Windows dan QuickTime.  

Pada Video for Windows terdapat pilihan software: 

• Cinepak Codec by Radius 

• DivX Pro 

• Indeo Video 5 

• Intel Indeo Video 3.2 

• Microsoft 

• Microsoft RLE 

Sedangkan pada QuickTime terdapat pilihan software: 

• Cinepak 

• DV-NTSC 

• DV-PAL 

• Intel Indeo Video 4.4 

• Sorenson Video 

• Sorenson Video 3 

Software kompresi tambahan yang dapat Anda download 

melalui internet diantaranya: 
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• Avisynth 

• Tmpeg 

• Xing MPEG Encoder, dll. 

  

4.2.3 Memainkan Digital Video 

File QuickTime yang diproduksi oleh Apple lebih bersifat umum 

(general), artinya dapat dimainkan oleh kedua system operasi, 

baik Microsoft Windows maupun Apple Macintosh. Hal ini yang 

mendukung Director MX menggunakan format QuickTime lebih 

optimal karena sesuai dengan kemampuan Director MX yang 

dapat dijalankan pada kedua system operasi tersebut.  

 

a. AVI (Microsoft Video for Windows) 

• Video = jika opsi Video ini diaktifkan dengan memberi 

tanda cek [ ], maka file AVI akan dimainkan 

gambarnya. Sebaliknya jika opsi ini dinonaktifkan dengan 

menghilangkan tanda cek [ ], maka file AVI hanya 

dimainkan suaranya saja. 

• Audio = jika opsi Audio ini diaktifkan dengan memberi 

tanda cek [ ], maka file AVI akan dimainkan suaranya. 

Sebaliknya jika opsi ini dinonaktifkan dengan 

menghilangkan tanda cek [ ], maka file AVI hanya 

dimainkan gambarnya saja. 

• Paused = jika opsi Paused ini diaktifkan dengan memberi 

tanda cek [ ], maka file AVI akan berhenti dulu sebelum 

ada perintah dimainkan. Sebaliknya jika opsi ini 

dinonaktifkan dengan menghilangkan tanda cek [ ], 

maka file AVI tidak dapat dihentikan ketika dimainkan. 
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• DTS (Direct to Stage) = jika opsi DTS ini diaktifkan 

dengan memberi tanda cek [ ], maka file AVI akan 

ditempatkan ke bagian terdepan pada stage serta 

memberi prioritas ke driver masing-masing file AVI untuk 

mengendalikan jalannya file tersebut secara penuh. 

• Loop = jika opsi Loop ini diaktifkan dengan memberi 

tanda cek [ ], maka file AVI akan dimainkan berulang-

ulang. Sebaliknya jika opsi ini dinonaktifkan dengan 

menghilangkan tanda cek [ ], maka file AVI hanya 

dimainkan sekali saja. 

• Preload = jika opsi Preload ini diaktifkan dengan 

memberi tanda cek [ ], maka file AVI akan di-load 

terlebih dahulu ke memori sebelum dimainkan. 

Sebaliknya jika opsi ini dinonaktifkan dengan 

menghilangkan tanda cek [ ], maka file AVI langsung 

dimainkan tanpa di-load terlebih dahulu ke memori. 

 

b. MOV (QuickTime) 

• Video = jika opsi Video ini diaktifkan dengan memberi 

tanda cek [ ], maka file MOV akan dimainkan 

gambarnya. Sebaliknya jika opsi ini dinonaktifkan dengan 

menghilangkan tanda cek [ ], maka file MOV hanya 

dimainkan suaranya saja. 

• Audio = jika opsi Audio ini diaktifkan dengan memberi 

tanda cek [ ], maka file MOV akan dimainkan suaranya. 

Sebaliknya jika opsi ini dinonaktifkan dengan 

menghilangkan tanda cek [ ], maka file MOV hanya 

dimainkan gambarnya saja. 
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• DTS (Direct to Stage) = jika opsi DTS ini diaktifkan 

dengan memberi tanda cek [ ], maka file MOV akan 

ditempatkan ke bagian terdepan pada stage serta 

memberi prioritas ke driver masing-masing file MOV 

untuk mengendalikan jalannya file tersebut secara 

penuh. 

• Loop = jika opsi Loop ini diaktifkan dengan memberi 

tanda cek [ ], maka file MOV akan dimainkan berulang-

ulang. Sebaliknya jika opsi ini dinonaktifkan dengan 

menghilangkan tanda cek [ ], maka file MOV hanya 

dimainkan sekali saja. 

• Controls = jika opsi Controls ini diaktifkan dengan 

memberi tanda cek [ ], maka controller (pengendali) file 

MOV yang ada pada Stage akan ditampilkan. Sebaliknya 

jika opsi ini dinonaktifkan dengan menghilangkan tanda 

cek [ ], maka controller (pengendali) file MOV yang ada 

pada Stage akan menghilang. 

• Streaming = jika opsi Streaming ini diaktifkan dengan 

memberi tanda cek [ ], maka file MOV dapat 

didistribusikan melalui internet. Sebaliknya jika opsi ini 

dinonaktifkan dengan menghilangkan tanda cek [ ], 

maka file MOV tidak dapat didistribusikan melalui 

internet. 

 

4.2.4 QuickTimeVersion 

Jika Anda menggunakan digital video dengan format MOV, 

pastikan pada sistem operasi Windows telah terinstalasi 

QuickTime Player. Jika tidak, ada kemungkinan sprite digital 
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video tersebut tidak dapat dimainkan. Untuk  memeriksa ada 

tidaknya QuickTime Player tersebut, gunakan perintah: 

quickTimeVersion() 

Contoh penggunaannya sebagai berikut: 

1.  buka jendela Message 

2.  Ketikkan perintah: 

 Put quicktimeversion() 

3.  tekan Enter 

 

4.2.5 Shockwave 3D 

Shockwave 3D adalah salah satu fasilitas dalam Director MX 

yang memungkinkan pengguna berinteraksi dengan sprite 

berbentuk Dimensi 3. 

 

1. Plugins  

Plugins saat ini perusahaan software 3D besar seperti 

3DMax (Discreet), Lightwave (Newtek), Alias WaveFront 

Maya dan lain-lainnya mendukung pembutan objek 3D yang 

dapat dimainkan oleh Director MX, dengan menyediakan 

fasilitas tambahan plug-in yang dapat di-download dari 

masing-masing website-nya. Plug-in tersebut berguna untuk 

mengekspor file yang dihasilkan oleh masing-masing 

software 3D ke dalam bentuk Shockwave yang dapat dibaca 

dan digunakan oleh Director MX. 

 

2. Menginstal Plugins 

a) pastikan PC Anda telah terinstalasi software 3DMax versi 

4 atau yang terbaru 

b) pastikan Anda telah memiliki file plug-in dengan nama 

SW3D_exp.dle 
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c) masukkan file tersebut dalam folder plug-in yang ada 

pada direktori software 3DMax 

d) restart PC Anda. 

 

3. Membuat File Shockwave 3D 

a) buka file 3D yang telah Anda buat dengan software 

3DMax 

b) buka menu File 

c) pilih Export 

d) pilih jenis file Shockwave 3D Scene Export (*.w3d) 

e) tuliskan nama file hasilnya 

f)  klik Save 

g) terlihat pilihan Preview Option, jika Anda mengaktifkan 

tanda tersebut maka Anda akan melihat hasilnya setelah 

selesai diproses 

h)  klik Export, kemudian Anda akan melalui proses 

exporting 

i)  setelah itu akan terlihat grafik Shockwave 3D Analysis 

j)  klik OK untuk melanjutkan dan menyelesaikan proses, 

maka Anda telah selesai membuat file format Shockwave 

3D berekstensi .W3D yang siap digunakan pada Director 

MX. 

 

4.  Memasukkan File Shockwave 3D 

a) buka Director MX 

b)  tekan Ctrl+R untuk mengimpor 

c)  pilih jenis file Shockwave 3D 

d)  pilih file berekstensi .W3D 

e)  klik Import 
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f)  sekarang Anda dapat melihat pada cast member 

terdapat member Shockwave 3D. 

 

5.  Memanipulasi Shockwave 3D Member 

Anda dapat memainkan warna pencahayaan, arah 

pencahayaan, latar belakang dan posisi Shockwave 3D 

member yang telah Anda masukkan ke dalam cast member 

sebelum ditampilkan pada stage. Untuk mengetahui tools 

yang terdapat pada jendela Shockwave 3D, klik-ganda cast 

member Shockwave 3D. Tools pada jendela Shockwave 3D: 

a)  Reset Camera Transform i) Play 

b)  Set Camera Transform j) Time 

c)  Root Lock k) Loop Playback 

d)  Reset World l) Dolly Camera 

e)  Step Backward m) Rotate Camera 

f)  Step Forward n) Pan Camera 

g)  Rewind o) Camera Y Up 

h)  Stop p) Camera X Up 

 

6.  Menggunakan Behavior Library 

Kelompok Behavior yang digunakan pada cast member 

Shockwave 3D adalah Action dan Triggers. Pada umumnya 

kedua kelompok tersebut digunakan secara bersamaan. 

 

a) Action  

Action adalah reaksi yang dibutuhkan cast member 

Shockwave 3D tersebut bergerak. Dalam kelompok 

Action terdapat beberapa fungsi untuk menganimasi cast 

member Shockwave 3D: 
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• Dolly Camera: menggerakkan kamera dengan posisi 

mendekati dan menjauhi objek pada cast Shockwave 

3D. 

• Drag Camera: menggerakkan kamera Pan, Rotate, 

dan zoom. 

• Fly Through: menggerakkan kamera dengan 

gerakkan terbang. 

• Pan Cemera Horizontal: menggerakkan kamera 

secara horizontal ke kiri dan ke kanan. 

• Pan Camera Vertical: menggerakkan kamera 

secara vertikal ke atas dan ke bawah. 

• Orbit Camera: menggerakkan kamera dengan orbit 

sumbu X, Y, dan Z. 

• Reset Camera: mengembalikan posisi kamera ke 

keadaan semula. 

• Rotate Camera: memutar kamera dengan 

pergerakan searah atau berlawanan jarum jam. 

• Automatic Model Rotation: memutar objek secara 

otomatis, di sini Anda dapat mengatur kecepatan 

perputaran dengan pilihan sumbu X, Y, atau Z. 

• Click Model Go To Marker: mirip perintah “Go to 

frame…”, di sini Anda terlebih dahulu memilih marker 

pada score, opsinya adalah “Previous”, “Loop”, atau 

“Next”. 

• Drag Model: menggerakkan model berdasarkan 

pergerakan secara vertikal, horizontal, maju, dan 

mundur. 

• Drag Model To Rotate: memutar model dengan 

sumbu X, Y, dan Z. 



82

 

• Model Rollover Cursor: berfungsi sama dengan 

Rollover Cursor. 

• Play Animation: membuat gerakan animasi pada 

program 3D seperti 3DMax. 

• Create Box: membuat objek berupa box ketika 

mouse di-klik pada area Shockwave 3D. 

• Create Particle: membuat partikel pada area sprite 

Shockwave 3D. 

• Create Sphere: membuat objek bulatan pada area 

sprite Shockwave 3D yang ada pada stage. 

• Level Of Detail: mengendalikan detail objek 3D 

yang berada dalam cast member Shockwave 3D. 

• Sub Division Surfaces: mengendalikan permukaan 

objek yang berada dalam cast member Shockwave 

3D. 

• Generic Do: untuk diisi dengan perintah Lingo. 

• Toggle Redraw: memberikan efek echo pada setiap 

objek yang digerakkan. 

• Toon: memberikan efek gambar kartun pada setiap 

pergerakan objek dalam cast member Shockwave 3D. 

• Show Axis: menampilkan tiap sumbu dari objek 

yang berada dalam cast member Shockwave 3D. 

 

b) Triggers  

Triggers adalah pemicu Action, pada umumnya di 

dalamnya adalah interaksi dari mouse dan keyboard. 

Dalam kelompok Triggers terdapat beberapa fungsi 

untuk memicu Action pada Shockwave 3D: 
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• Mouse Left: pemicu yang menggunakan klik tombol 

kiri mouse. 

• Mouse Right: pemicu yang menggunakan klik 

tombol kanan mouse. 

• Mouse Enter: pemicu yang menggunakan event 

“mouse enter” ke atas objek dalam sebuah cast 

member Shockwave 3D. 

• Mouse Within: pemicu ini digunakan untuk 

mendeteksi posisi kursor mouse ketika berada dalam 

objek yang ada pada cast member Shockwave 3D. 

• Mouse Leave: digunakan untuk mengenali saat 

mouse keluar dari objek dalam sebuah cast member 

Shockwave 3D. 

• Keyboard Input: pemicu ini digunakan untuk 

mengendalikan cast member Shockwave 3D dengan 

menggunakan tombol keyboard. 

 

4.2.6 Kompilasi 

Tahap terakhir dari pembuatan sebuah movie adalah persiapan 

distribusi agar movie yang Anda buat dapat dijalankan pada PC 

lain tanpa harus menginstalasi Macromedia Director MX 2004. 

 

1. Xtra  

Jika Anda telah menyelesaikan movie yang di dalamnya 

terdapat Xtra, maka Anda harus menyertakan Xtra tersebut 

ke dalam movie yang hendak dibuat projector (compile). 

Penggabungan Xtra dibagi menjadi 2 macam: 

a) Xtra digabungkan ke dalam satu folder khusus (biasanya 

diberi nama “xtras”), bersamaan dengan file projector. 
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Untuk langkah ini Anda dapat meng-copy langsung 

folder Xtras yang disertakan dalam program Director MX. 

Folder ini berisi 10 buah subfolder standar yaitu: 

Accessibility, ActiveX, Devices, Filter Support, Flash 

Asset, Havok, Media Support, Mix, Net Support, dan Qt. 

 Penggabungan dengan metode ini cukup baik karena 

tidak memberatkan projector. 

b) Xtra dimasukkan ke dalam projector (dikompilasi menjadi 

satu dalam projector). Dengan menggunakan cara ini file 

projector akan menjadi besar, namun kelebihannya 

adalah waktu proses yang cepat dalam membuka 

projector. Cara kompilasinya adalah sebagai berikut: 

buka menu Modify  klik Movie   klik Xtras  klik Add 

untuk menambahkan Xtras ke dalam projector  pilih 

Xtras yang Anda inginkan, kemudian klik OK  klik Ok 

untuk menutup jendela Movie Extras. 

 

2. Save and Compact 

Save and Compact digunakan untuk menghapus variabel 

statis pada memori. Sebelum Anda membuat projector, ada 

baiknya Anda selalu menggunakan fasilitas ini untuk 

meningkatkan kinerja movie Anda. Langkah untuk 

menggunakan Save and Compact adalah sebagai berikut: 

buka Movie yang Anda ingin proses dengan Save and 

Compact  klik menu File  klik Save and Compact. 

 

3. Movie dalam Bentuk Shockwave 

Selain dalam bentuk projector, cara lain untuk 

mendistribusikan movie adalah melalui internet. Dengan 
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media internet, biasanya movie dikompilasi dalam format 

Shockwave. Dengan format ini, Anda dapat meng-upload-

nya ke server Anda, namun biasanya untuk melihat hasil 

movie tersebut, browser Anda membutuhkan plug-ins yang 

dapat di-download dari situs Macromedia: 

http://www.macromedia.com/shockwave/download 

Format dalam bentuk Shockwave Internet berbeda dengan 

movie. File yang dihasilkan akan berekstensi .DCR. 

Langkah untuk membuat file dalam bentuk Shockwave yang 

dapat didistribusikan melalui internet adalah sebagai 

berikut: 

a) buka movie yang akan Anda publish menjadi format 

Shockwave 

b)  klik menu File 

c)  pilih Publish Settings untuk membuat setting movie yang 

akan di-publish 

d) bukalah masing-masing Tab-nya, tentukan setting yang 

tepat untuk movie Anda 

e)  klik tombol OK 

f)  tekan Ctrl+Shift+S atau pilih Publish pada menu File. 

 

4.  Stub Projector 

Stub Projector adalah teknik membuat projector kosong 

untuk memanggil movie yang sesungguhnya. Teknik ini 

digunakan untuk mempercepat proses loading. Stub 

Projector hanya dibuat untuk memanggil movie yang 

sesungguhnya melalui movie script yang langsung 

dijalankan pada saat movie stub berjalan, berikut langkah 

untuk membuat Stub Projector: 
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a)  buatlah sebuah movie baru 

b)  tekan Ctrl+Shift+U untuk membuat movie script 

c)  masukkan perintah di bawah ini pada movie script: 

 On startMovie 

        Go to movie “...” 

 End startMovie 

 

5.  Memproteksi Movie 

Pada saat Anda mengirimkan movie dalam CD atau media 

lainnya, tentunya Anda tidak ingin pihak pengguna dapat 

mengubah isi movie Anda.  

Untuk memproteksi agar movie tidak dapat diubah dengan 

membuka sumbernya (file: .DIR), maka gunakan perintah 

Update. Hasil akhir dari file yang diproteksi adalah . DXR. 

Anda ataupun pengguna lainnya tetap dapat 

menjalankannya namun tidak dapat lagi membuka file ini 

dengan menggunakan Macromedia Director MX. 

Langkah memproteksi movie adalah sebagai berikut: 

a)  pastikan Anda telah memiliki backup file yang asli, untuk 

itu copy-lah file movie asli Anda ke directory yang 

berbeda 

b)  klik menu Xtras 

c)  pilih menu Update Movies, maka Anda akan melihat 

jendela Update Movies 

d)  klik pilihan Protect 

e)  pada bagian Original Files terdapat 2 buah pilihan, yaitu: 

• Backup Into Folder: opsi ini dipilih jika Anda ingin 

file movie yang asli (.DIR) di-backup oleh Director MX 

ke dalam sebuah folder yang Anda tentukan. 
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• Delete: opsi ini dipilih jika Anda ingin file movie yang 

asli (.DIR) dihapus dan hanya menyisakan file movie 

yang telah diproteksi. 

f)  klik tombol Browse untuk memcari folder lokasi backup 

file movie 

g)  pilih lokasi folder, kemudian klik tombol Select Folder 

h)  klik tombol Update Movies Options 

i)  pilih file yang akan Anda proteksi 

j)  klik tombol Add untuk memasukkan file pilihan ke dalam 

File List 

k)  setelah selesai, klik tombol Proceed 

l)  klik tombol Continue (jika Anda ingin meneruskan 

proses) atau klik tombol Cancel (jika Anda ingin 

membatalkan proses) 

m) Anda lihat proses proteksi movie sehingga selesai. 

 

4.2.7 Fitur Program Pembuatan CD 

Untuk mengemas file Director MX ini kita gunakan program 

Nero Burning ROM 6 Ultra Edition (Nero Express 6).  

 

 

 

Program ini memiliki 6 menu berikut beberapa fitur pilihan yang 

sangat mendukung pendistribusian produk multimedia. Keenam 

menu tersebut adalah: 

 

1. Favorites 

a) Make Data Disc: membuat CD Data yang dapat dibaca 

pada PC 
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b) Make Audio CD: membuat CD Audio yang dapat 

dimainkan pada CD Player/PC 

c) Make Video CD: membuat CD Video (VCD) yang dapat 

diputar pada VCD/DVD Player 

d) Copy Disc: menyalin seluruh isi master CD ke CD salinan 

e) Back up Files: membuat cadangan File/Folder (Data) ke 

CD. 

 

2. Data 

a) Make Data Disc: membuat CD Data yang dapat dibaca 

pada PC 

b) Make Audio and Data CD: membuat CD terpadu yang 

Audio-nya hanya dapat dimainkan pada CD Player dan 

Data-nya hanya dapat dibaca pada PC. 

 

3. Audio 

a) Make Audio CD: membuat CD Audio yang dapat 

dimainkan pada CD Player/PC 

b) Make MP3 Disc: membuat CD MP3 yang dapat dimainkan 

pada PC dan CD/VCD/DVD yang dapat membaca file 

MP3 

c) Make WMA Disc: membuat CD WMA yang dapat 

dimainkan pada PC dan CD/VCD/DVD yang dapat 

membaca file WMA 

d) Make AAC Disc: membuat CD AAC yang dapat dimainkan 

pada PC dan CD/VCD/DVD yang dapat membaca file AAC 

e) Make Audio and Data CD: membuat CD terpadu yang 

Audio-nya hanya dapat dimainkan pada CD Player dan 

Data-nya hanya dapat dibaca pada PC. 
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4. Photo and Video 

a) Make Video CD: membuat CD Video (VCD) yang dapat 

diputar pada VCD/DVD Player 

b) Make Super Video CD: membuat CD Super Video (S-

VCD) yang dapat diputar pada DVD Player. 

 

5. Copy and Backup 

a) Copy Disc: menyalin seluruh isi master CD ke CD salinan 

b) Back up Files: membuat cadangan File/Folder (Data) ke 

CD 

c) Restore Backups: merestorasi File/Folder cadangan 

dengan sekali klik! 

d) Schedule Backups: menata dan mengatur jadual reguler 

pencadangan File/Folder 

e) Burn Image on Disc: membuat salinan File/Folder dari 

image Data ke CD. 

 

6. Extras 

a) Get System Info: mencari informasi tentang Drive CD 

dan konfigurasinya. 

b) Test Drive: menguji performa dan kualitas Drive CD 

c) Erase Disc: menghapus CD-RW dengan sekali klik! 

d) Make Label or Cover: mendesain dan mencetak 

label/sampul CD 

e) Control Drive's Speed: mengatur kecepatan dan putaran 

Drive CD. 
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4.2.8 Pengemasan Ke Dalam CD 

Mengemas Director MX adalah tahapan akhir dari proses 

pengembangan aplikasi multimedia serta pendistribusiannya 

kepada pengguna. 

Sebelum mengemas (burning) file distribusi Director MX, 

pastikanlah terlebih dahulu bahwa semua file telah terkompilasi, 

terproteksi dan siap dikemas ke CD. 

Tahapan mengemas (burning) ke dalam CD adalah sebagai 

berikut: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 1. Membuka program Nero Express 6 
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 2. Sambutan dari Nero Express 6 

 

 

 

 

 

 

 

 

 

 

 

 

 3. Memilih fitur Make Data Disc dari Menu Favorites 
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 4. Memasukkan File/Folder ke dalam jendela Disc Content 
dengan tombol Add 
 

 

 

 

 

 

 

 

 

 

 5. Memilih Folder yang berisi File/Folder yang akan dikemas ke 
dalam CD 
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 6. Memilih File/Folder yang akan dikemas ke dalam CD 

 

 

 

 

 

 

 

 

 

 

 

 

 7. Memeriksa File/Folder yang akan dikemas di jendela Disc 
Content, tekan tombol Next untuk melanjutkan proses 
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 8. Memberi nama CD dan memilih kecepatan penulisan CD, 
tersedia opsi Writing Speed: 
• 4x = 600 KiloByte per-detik 
• 8x  = 1.200 KiloByte per-detik 
• 12x  = 1.800 KiloByte per-detik 
• 16x  = 2.400 KiloByte per-detik 
• 24x  = 3.600 KiloByte per-detik 
• 32x  = 4.800 KiloByte per-detik 
• 40x  = 6.000 KiloByte per-detik 

 

 

 

 

 

 

 

 

 

 

 

 

 9. Memilih Allow files to be added later (multisession disc) 
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 10. Proses pengemasan (burning)… 
 

 

 

 

 11. Proses sukses dan selesai 
 

 

 

 

 

 

 

 

 

 

 

 

 12. Proses pengemasan sukses dan selesai... 
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4.3 Rangkuman 4 

4.3.1 Dua buah format utama digital video yang dapat dimainkan 

oleh Director MX 2004 adalah: (1) Video for Windows, dan (2) 

QuickTime (dapat dimainkan di system operasi Macintosh 

maupun Windows). 

4.3.2 Kompresi video untuk multimedia secara umum dibagi menjadi 

dua jenis, yaitu Video for Windows dan QuickTime. Software 

kompresi video untuk Video for Windows antara lain: Cinepak 

Codec by Radius, DivX Pro, Indeo Video 5, Intel Indeo Video 

3.2, Microsoft, dan Microsoft RLE. Sedangkan software 

kompresi video untuk QuickTime antara lain: Cinepak, DV-

NTSC, DV-PAL, Intel Indeo Video 4.4, Sorenson Video, dan 

Sorenson Video 3. 

4.3.3 File QuickTime yang diproduksi oleh Apple dapat dimainkan 

oleh kedua sistem operasi, baik Microsoft Windows untuk file 

AVI maupun Apple Macintosh untuk file MOV. Director MX 

memainkan AVI dengan opsi aktivasi: (1) Video, (2) Audio, (3) 

Paused, (4) Direct To Stage, (5) Loop, dan (6) Preaload. 

Sedangkan MOV dimainkan dengan opsi aktivasi: (1) Video, (2) 

Audio, (3) Direct To Stage, (4) Loop, (5) Controls, (6) 

Streaming. 

4.3.4 QuickTime Player harus terinstalasi pada sistem operasi 

Windows sebelum Anda memainkan digital video yang 

berformat MOV. 

4.3.5 Shockwave 3D adalah fasilitas dalam Director MX yang 

memungkinkan pengguna berinteraksi dengan sprite berbentuk 

Dimensi 3. 

4.3.6 Kompilasi adalah penyertaan file atau folder ke dalam movie 

agar movie yang Anda buat dapat dijalankan pada PC lain 
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tanpa harus menginstalasi Macromedia Director MX 2004. 

Kompilasi dapat dilakukan dengan metode kombinasi: (1) 

menyertakan Xtra, (2) Save and Compact, (3) Movie dalam 

bentuk Shockwave, (4) Stub Projector, (5) memproteksi Movie. 

4.3.7 Nero Burning ROM 6 Ultra Edition adalah program aplikasi 

penyalinan data (burning) ke media cakram digital (CD), 

program aplikasi ini memiliki menu: (1) Favorites, (2) Data, (3) 

Audio, (4) Photo and Video, (5) Copy and Backup, dan (6) 

Extras. Adapun menu Favorites terdiri submenu-submenu 

operasi yang sering dipergunakan oleh pengembang aplikasi 

multimedia, yaitu: (1) Make Data Disc, (2) Make Audio CD, (3) 

Make Video CD, (4) Copy Disc, dan (5) Back up Files. 

4.3.8 Sebelum mengemas (burning) file distribusi Director MX, 

pastikanlah terlebih dahulu bahwa semua file telah terkompilasi, 

terproteksi dan siap dikemas ke CD. Tahapan mengemas 

(burning) ke dalam CD adalah sebagai berikut: 

(1)  Membuka program Nero Express 6 

(2)  Memilih fitur Make Data Disc dari Menu Favorites 

(3)  Membuka jendela Disc Content 

(4) Memilih files/folder pilihan yang akan dikemas dari jendela 

Select Files and Folders 

(5) Memeriksa file/folder yang terpilih di jendela Disc Content 

(6) Memberi nama CD yang akan di-burn 

(7) Memilih kecepatan proses penulisan CD 

(8) Menentukan opsi multi-sesi dan jumlah duplikasi 

(9) Melakukan eksekusi penulisan (burning) CD 

 

4.4 Tugas 4 



98

 

4.4.1 Lakukan kompilasi pada file multimedia interaktif 

Ekstrakurikuler yang telah diselesaikan di Kegiatan Belajar 3. 

4.4.2 Siapkan 1 keping CD blank dan program aplikasi Nero Burning 

ROM 6 Ultra Edition, kemudian lakukan penyalinan (burning) 

file multimedia interaktif Ekstrakurikuler tersebut ke dalam CD 

dengan kecepatan proses 24x (3.600 Kbps). 

4.4.2 Buka file multimedia interaktif Ekstrakurikuler, kemudian 

konversi menjadi Shockwave 3D agar dapat dijalankan di web 

(internet). 

 

4.5 Tes Formatif 4 

4.5.1 Lakukan --- 

4.5.2 Jalankan --- 

 

4.6 Kunci Jawaban Formatif 4 

4.6.1 Lihat kembali materi 4 

 

4.7 Lembar Kerja 4 

4.7.1 Alat dan bahan 

1 (Satu) unit komputer dengan spesifikasi minimum Pentium III 

450 yang telah diinstalasi program aplikasi Director MX. 

 

4.7.2 Kesehatan dan Keselamatan Kerja 

a. Membaca do’a sebelum memulai kegiatan belajar. 

b. Membaca dan memahami petunjuk praktikum pada setiap 

lembar kegiatan belajar. 

c. Memastikan komputer dalam keadaan baik dan semua kabel 

penghubung terkoneksi dengan baik. 
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d. Menjauhkan benda yang dapat mengeluarkan medan 

elektromagnetik di dekat komputer (magnet, handphone, 

dan sebagainya). 

e. Menggunakan komputer sesuai fungsinya dengan hati-hati. 

f. Setelah selesai, mematikan komputer dengan benar. 

  

4.7.3 Langkah Kerja 

a. Memeriksa semua kabel penghubung pada komputer. 

b. Menghidupkan komputer dengan menekan saklar pada 

komputer, jangan menghidupkan komputer dengan 

memasukkan steker ke stop kontak ketika saklar dalam 

keadaan on. 

c. Jika komputer telah hidup, mengaktifkan program aplikasi 

Nero Burning ROM 6 Ultra Edition, menunggu hingga proses 

loading selesai. 

d. Melakukan proses penyalinan (burning) CD. 

e. Jika telah selesai, menutup program Director MX di 

komputer Anda dan mematikan komputer dengan benar. 
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Bab III Evaluasi 
 

 

A. PERTANYAAN 

1. Jelaskan fungsi jendela-jendela Director MX di bawah ini! (skor 10) 

a. Stage  

b. Score  

c. Cast  

d. Property Inspector, dan  

e. Control Panel 

2. Jelaskan, gambarkan struktur dan contohkan aplikasi.. (skor 10) 

a. Multimedia Interaktif 

b. Multimedia Linier 

3. Jelaskan fungsi cast member Action Shockwave 3D berikut.. (skor 20) 

a. Dolly Camera 

b. Fly Through 

c. Orbit Camera 

d. Generic Do 

e. Show Axis 

4. Jelaskan cara membuat file Shockwave 3D! (skor 40) 

5. Jelaskan cara mengemas movie ke dalam CD interaktif! (skor 20) 

 

B. KUNCI JAWABAN EVALUASI 

1. --- 

2. --- 

3. --- 

4. --- 

5. --- 
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C. KRITERIA KELULUSAN 

Aspek 
Skor 

(1-10) 
Bobot Nilai Keterangan 

Kognitif (soal no 1 s/d 5)  3  

Kebenaran langkah  3  

Kerapian, kebersihan, ketelitian  2  

Ketepatan waktu  2  

Nilai Akhir  

Syarat lulus nilai 
minimal 70 dan skor 
setiap aspek minimal 7 
 

 

Kategori kelulusan: 

70 – 79 : Memenuhi kriteria mininal. Dapat bekerja dengan bimbingan. 

80 – 89 : Memenuhi kriteria minimal. Dapat bekerja tanpa bimbingan. 

90 – 100 : Di atas kriteria minimal. Dapat bekerja tanpa bimbingan. 
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Bab IV Penutup 
 

 

Demikianlah modul pemelajaran Mengembangkan Aplikasi Multimedia. 

Materi yang telah dibahas dalam modul ini masih sangat sederhana. Hanya 

sebagai dasar saja bagi peserta diklat untuk belajar lebih lanjut. Diharapkan 

peserta diklat memanfaatkan modul ini sebagai motivasi untuk mengembangkan 

aplikasi multimedia lebih jauh sehingga peserta diklat dapat merancang berbagai 

macam tampilan multimedia interaktif yang dikehendaki. 

Setelah menyelesaikan modul terakhir ini dan mengerjakan semua tugas serta 

evaluasi maka berdasarkan kriteria penilaian, peserta diklat dapat dinyatakan 

lulus/tidak lulus. Apabila dinyatakan lulus maka peserta diklat dinyatakan telah 

lulus dan mengusai kompetensi Multimedia, sedangkan apabila dinyatakan tidak 

lulus maka peserta diklat harus mengulang modul ini. 
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Pustaka Online 
 
 
 
http://amcomm.org/lingosig 
http://etosoftware.hypermart.net/minirun.htm 
http://rampages.onramp.net/~bennet/devtools 
http://superlingo.level.ni 
http://users.aol.com/jrbuell/index.html 
http://www.3dlinks.com/community_shockwave3D.cfm 
http://www.behaviors.com 
http://www.clevermedia.com/resources 
http://www.director8.com 
http://www.director-online.com 
http://www.grommet.com 
http://www.kkti.com/lingo 
http://www.komunitasinteraktif.com 
http://www.macromedia.com 
http://www.mcli.dist.maricopa.edu/director/ 
http://www.mediamacros.com 
http://www.moshplant.com/direct-or/ 
http://www.piggelin.com/macromedia/main.htm 
http://www.sfx.co.nz/tamahori/ 
http://www.xtramedia.com/lingotip.shtml 
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